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Software License Agreement 
This Software License Agreement (“License Agreement”) is a legal agreement between you (either an individual or a single entity) and Serif 
(Europe) Ltd. (“Serif”) for the accompanying software product, which includes computer software and may include associated media, printed 
materials, and “online” or electronic documentation (the “Software Product”). By installing, copying, or otherwise using the Software Product, 
you agree to be bound by the terms of this License Agreement. If you do not agree to the terms and conditions of this License Agreement, do 
not install or use the Software Product; you may, however, return it to your place of purchase for a full refund. 
THANK YOU FOR LICENSING THE USE OF THE SOFTWARE PRODUCT. IT IS IMPORTANT THAT YOU (THE “LICENSEE”) READ 
THIS NOTICE CAREFULLY. THESE ARE THE ONLY TERMS AND CONDITIONS APPLICABLE TO YOUR RIGHTS WITH RESPECT 
TO THE SOFTWARE PRODUCT. THE SOFTWARE PRODUCT IS PROTECTED BY COPYRIGHT LAWS AND INTERNATIONAL 
COPYRIGHT TREATIES, AS WELL AS OTHER INTELLECTUAL PROPERTY LAWS AND TREATIES. THE SOFTWARE PRODUCT 
IS LICENSED, NOT SOLD. 

  

1. GRANT OF LICENSE 

Serif hereby grants to Licensee a personal, non-exclusive, non-
transferable license (a “License”) to use one (1) copy of the 
Software Product, including any updates thereto, and 
accompanying documentation, if any, provided by Serif, according 
to the terms set forth below. If the Software Product is being 
provided to Licensee as an update or upgrade to software which 
Licensee has previously licensed (such software referred to as the 
“Prior Software”), then Licensee agrees to destroy all copies of the 
Prior Software within thirty (30) days after opening this package 
except for one backup copy of the Prior Software. 

 

2. SCOPE OF USE 

You may install and use one copy of the Software Product, on a 
single computer. The primary user of the computer on which the 
Software Product is installed may make a second copy for his or her 
exclusive use on a portable computer. Licensee may also store or 
install a copy of the Software Product on a storage device, such as a 
network server, used only to install or run the Software Product on 
other computers over an internal network; however, you must 
acquire and dedicate a license for each separate computer on which 
the Software Product is installed or run from the storage device. A 
license for the Software Product may not be shared or used 
concurrently on different computers. 

 

3. LICENSE PAK 

If you have acquired this License Agreement in a Serif License Pak, 
you may make the number of additional copies of the computer 
software portion of the Software Product as authorized in the Serif 
License Pak, and you may use each copy in the manner specified 
above. You are also entitled to make a corresponding number of 
secondary copies for portable computer use as specified above. 

 

4. PROHIBITIONS 
You may not: modify, prepare derivative works from, translate, 
reverse engineer, decompile, disassemble or otherwise derive source 
code from the Software Product (except to the extent that such acts 
are expressly permitted by applicable law notwithstanding this 
limitation); copy the Software Product (except as provided above) 
or the accompanying documentation; rent, transfer, disclose, make 
available or grant any rights in the Software Product (including any 
accompanying documentation) in any form to any person without 
the prior written consent of Serif; remove any proprietary notices, 
labels, or marks on the Software Product (including any 
accompanying documentation); use the Software Product in any 
manner that infringes the intellectual property or other rights of 
another party; or use the Software Product to provide on-line or 
other database services to any other person. 

 

5. RETENTION OF RIGHTS; TERMINATION 

This License Agreement does not constitute a sale. All title, trade 
secrets, copyrights, patents and other intellectual rights to the 
Software Product, its accompanying documentation and any copy 
made by Licensee remain with Serif, and Licensee hereby agrees to 
preserve and acknowledges the foregoing. Licensee further agrees 
and acknowledges that the Software Product and all copies thereof 
are Serif’s exclusive property and constitute a valuable trade secret 
of Serif. Licensee further agrees and acknowledges that 
unauthorized copying of the Software Product or the accompanying 

documentation, or failure to comply with any of the provisions 
hereof (each, a “Terminable Event”), will result in automatic 
termination of this License. In the event of a violation of this 
License by Licensee, Serif reserves and shall have available all legal 
remedies. 

 

6. TERM OF LICENSE FOR TRIAL VERSION SOFTWARE 
The License pertaining to a trial version of the Software Product (a 
“Trial Version”) shall expire in accordance with the terms as set 
forth in the installation process for the Trial Version along with the 
designated trial period as set forth in the trial program.  

 
7. LIMITED WARRANTY AND DISCLAIMER 
Serif warrants that, for a period of ninety (90) days after delivery, 
the diskettes or CD-ROMs on which the software included in the 
Software Product is furnished will, under normal use, be free from 
defects that prevent Licensee from loading the Software Product on 
a computer. Serif’s entire liability and Licensee’s exclusive remedy 
under this warranty will be, at Serif’s option, to (a) use reasonable 
commercial efforts to attempt to correct or work around errors, or 
(b) to replace the Software Product with functionally equivalent 
Software Product, on diskettes or CD-ROM, as applicable or (c) 
return the price paid for the Software Product, in each case upon 
return of the Software Product to Serif together with a copy of your 
receipt for the purchase thereof. This Limited Warranty is void if 
failure of the Software Product or hardware has resulted from 
accident, abuse, or misapplication. Any replacement Software 
Product will be warranted for the remainder of the original warranty 
period or thirty (30) days, whichever is longer. Outside the United 
States, neither these remedies nor any product support services 
offered by Serif are available without proof of purchase from an 
authorized non-U.S. source. The Software Product is licensed to 
you on an “as is” basis without any warranty of any nature. 

 
8. NO OTHER WARRANTIES 
Except for the above express limited warranties, Serif and its 
suppliers make and licensee receives no warranties or conditions, or 
terms, express, implied, statutory, or in any communication with 
licensee. To the maximum extent permitted by applicable law, Serif 
and its suppliers disclaim all other warranties and conditions, either 
express or implied, including, but not limited to, implied warranties 
of merchantability, fitness for a particular purpose, title and non-
infringement, with regard to the software product and the provision 
of or failure to provide support services. Licensee shall be solely 
responsible for the selection, use, efficiency and suitability of the 
software product and serif shall have no liability therefor. Serif shall 
have no liability for, nor obligation to indemnify licensee regarding 
actions alleging the infringement of proprietary rights by the 
software product. Serif does not warrant that the operation of the 
software product will be uninterrupted or error free or that the 
software product will meet licensee’s specific requirements. The 
Limited Warranty gives you specific legal rights. You may have 
others, which vary from state/jurisdiction to state/jurisdiction. 

 
 
 
 
 
 



9. LIMITATION OF LIABILITY 
In no event will Serif or its suppliers be liable for loss of data, 
corruption, lost profits, cost of cover, or other special, incidental, 
punitive, consequential, or indirect damages arising from the use of 
the software product (including any accompanying documentation), 
however caused and on any theory of liability. This limitation will 
apply even if Serif or an authorized distributor has been advised of 
the possibility of such damage. In no event will Serif’s liability 
exceed the amount paid for the software product. Licensee 
acknowledges that the amounts paid by licensee for the software 
product reflect this allocation of risk. Some states or other 
jurisdictions do not allow the exclusion or limitation of liability for 
incidental or consequential damages, so the above limitations and 
exclusions may not be applicable in certain instances. None of the 
above affects the statutory rights of licensees residing in the United 
Kingdom. 

 

10. NOT FOR RESALE SOFTWARE 

If the Software Product is labeled “Not for Resale” or “NFR,” then, 
notwithstanding section 1 of this License, your use of the Software 
Product is limited to use for demonstration, test, or evaluation 
purposes.  
 

11. NO RENTAL; OTHER TRANSFERS 
You may transfer this License to another computer or workstation 
only on a permanent basis (that is, with no intent to transfer again) 
provided the computer, workstation, or other digital electronic 
device from which you have transferred this License no longer 
accesses or otherwise utilizes the Software Product, and the 
Software Product is used in accordance with the terms of this 
License Agreement.  

 

12. TERMINATION 
You may terminate this License Agreement at any time. Serif may 
terminate this License Agreement if you fail to comply with the 
terms and conditions of this License Agreement. In either event, 
you must destroy all copies of the Software Product.  

 

13. UPGRADE 
If this License is an “Upgrade,” you must have a valid license for 
the Prior Software for this License Agreement to be valid, and this 
License Agreement must be used to replace such license for the 
Prior Software. The total number of license “Upgrades” you may 
acquire may not exceed the total number of computers, 
workstations, or other digital electronic devices that were licensed to 
access or otherwise utilize the Software Product at the time you 
upgraded the Software Product. 

 

14. GUIDELINES FOR THE USE OF DIGITAL CONTENT 
IMAGES  

This product contains numerous clipart and photo images 
(collectively referred to as the “Images”) which are either owned by 
Serif or licensed from a third party. As a user of this product you are 
free to use, modify, and publish the Images as you wish subject to 
the restrictions set out below. If you are uncertain as to whether 
your intended use complies with the guidelines set out below, we 
recommend that you seek the advice of your own attorney or legal 
counsel. 

A. YOU MAY, subject to any restrictions set out below: 

1. Incorporate any Image(s) into your own original work and 
publish, display, and distribute your work in any media. You may 
not, however, resell, sublicense, or otherwise make available the 
Image(s) for use or distribution separately or detached from a 
product or Web page. For example, the Image(s) may be used as 
part of a Web page design, but may not be made available for 
downloading separately or in a format designed or intended for 
permanent storage or reuse by others. Similarly, clients may be 
provided with copies of the Image(s) (including digital files) as an 
integral part of a work product, but may not be provided with the 
Image(s) or permitted to use the Image(s) separately or as part of 
any other product; 

2. Make one (1) copy of the Image(s) for backup or archival 
purposes. 

 

B. YOU MAY NOT: 

1. Create scandalous, obscene, defamatory, or immoral works using 
the Image(s) nor use the Image(s) for any other purpose prohibited 
by law; 

2. Use or permit the use of the Image(s) or any part thereof as a 
trademark or service mark, or claim any proprietary rights of any 
sort in the Image(s) or any part thereof; 

3. Use the Image(s) in electronic format, on-line, or in multimedia 
applications unless (a) the Image(s) are incorporated for viewing 
purposes only and (b) no permission is given to download and/or 
save the Image(s) for any reason; 

4. Rent, lease, sublicense, or lend the Image(s), or a copy thereof, to 
another person or legal entity. You may, however, transfer all your 
license to use the Image(s) to another person or legal entity, 
provided that (a) you transfer the Image(s) and this License, 
including all copies (except copies incorporated into your work 
product as permitted under this License), to such person or entity, 
(b) that you retain no copies, including copies stored on a computer 
or other storage device, and (c) the receiving party agrees to be 
bound by the terms and conditions of this License; 

5. Use any Image(s) except as expressly permitted by this License. 

 

15. MISCELLANEOUS 
This Agreement shall not be governed by the 1980 U. N. 
Convention on Contracts for the International Sale of Goods; rather, 
this Agreement shall be governed by English law. This Agreement 
constitutes the entire agreement between Serif and Licensee and 
supersedes all prior agreements, understandings, communications, 
advertising, proposals or representations, oral or written, by either 
party. If any provision of this Agreement is held invalid or 
unenforceable, such provision shall be revised to the extent 
necessary to cure the invalidity or non-enforceability, and the 
remainder of this Agreement shall continue in full force and effect. 
This Agreement shall be amended only by an executed writing by 
authorized representatives of both parties. 



How to contact us 

Our main office (USA, Canada): 
The Software Center 
13 Hampshire Drive, Suite 12, Hudson NH 03051 

Main   (603) 889-8650 
Registration  (800) 794-6876 
Single Unit Sales  (800) 55-SERIF or 557-3743 
Technical Support (603) 886-6642 
Customer Service  (800) 489-6720 
General Fax  (603) 889-1127 

Technical Support E-mail support@serif.com 
 

European office (UK, Europe): 
The Software Centre 
PO Box 2000, Nottingham, NG11 7GW, UK 

Main   (0115) 914 2000 
Registration  (0500) 454 645 
Sales   (0800) 376 4848 
Technical Support* (0115) 914 9090  
Customer Service* (0115) 914 9090 
General Fax  (0115) 914 2020  

*Local rate (UK only) (0845) 345 6770 

Technical Support E-mail support@serif.co.uk 

Online 
Visit us on the Web at http://www.serif.com 
Serif Newsgroups news://news.serif.com 

International 
Please contact your local distributor/dealer. For further details please 
contact us at one of our phone numbers above. 
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Welcome 
Ready to add a new dimension to your Web graphics projects, digital 
movies, presentations, or desktop publishing? ImpactPlus will take you 
there! And no special skills are required—whether you use Wizards to 
create and customize instant scenes, or construct your own from 
scratch. ImpactPlus puts all the tools and resources you’ll need within 
easy reach. You just pick and choose, mix and match—embellish and 
tweak to your heart’s content. The professional-quality results will 
amaze you! 

About the Companion 
This Companion is your guide to getting started and getting results 
with ImpactPlus—from initial installation through advanced tips and 
examples. 

1 Welcome. Read on for a feature summary—a checklist of the 
fun that’s in store for you.  

2 Getting Started. How to get up and running, and create 
instant 3D designs and animations. 

3 Setting the Scene. A sequence of guided tours to introduce you 
to all the basic elements of the ImpactPlus interface. 

4 Making It Move. How to add movement to your static scenes 
for eye-catching animations and movie clips. 

5 Waxing Creative. Beyond the basics... more theory and 
practice to improve your use of text, bevel, color, texture, and 
deformation. Plus the secrets of anaglyph (stereo) imaging!   

6 Building New 3D Objects. A comprehensive look around the 
3D Workshop, where you’ll be building your own sophisticated 
models in no time at all. 

7 Working with Other Software. How to incorporate your 
ImpactPlus creations in a video, publication, presentation, or 
desktop publishing program. 

     
“Vertex Fog” background effect 
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What You’ll Find in ImpactPlus... 
Whether you’re a novice, a digital dabbler, or an old hand with 3D 
modeling, here’s a quick summary of what’s in store for you. Check 
the Welcome topic in online Help for direct links to detailed coverage.  

♦  Welcome to the Microworld! 
ImpactPlus gives you a limitless stage where you can create your 
own production—combining 3D text, geometric models, 
backgrounds, lighting effects, multiple cameras, and much more! 
It’s easy to create a static scene and add optional animation. 
Browse ready-made models, from basic shapes to complex 
technology. Or use QuickShapes for your own adjustable instant 
objects... assemble into groups... reshape any model like plastic! 
Scene planes let you carve out a multi-dimensional virtual space. 

♦  Lights... 
Every new scene includes a built-in light source at your 
viewpoint... switch it on or off as needed, while setting up your 
custom lighting scheme. Choose and customize a scheme from the 
wide range of presets on the Studio’s Lights tab... or add your own 
lights one by one. Use advanced lighting controls and effects, even 
cast shadows—with multiple color components to set the “quality” 
of each light’s output, each object’s reflectance.  

♦  Camera... 
Choose from six preset viewpoint angles, or simply drag for 
freeform viewpoints and object rotations. Achieve tilts and swivels 
in all three dimensions with intuitive orbit adjustments. Even 
move the viewpoint around without disturbing its custom angle. If 
one view won’t do, you can open secondary scene windows for 
more vantage points and easier object manipulation.  

♦  Action! 
Make any static 3D scene come alive! The Studio’s Animation tab 
even comes pre-loaded with dozens of exciting animated effects that 
you can click to apply to text and objects. Or you can place your own 
key frames for object properties you want to vary—let ImpactPlus 
generate the in-between motion as objects move, rotate, change size or 
color, and much more. The result: an animated GIF or AVI movie clip!  

♦  Not Real Enough? Grab Your 3D Specs! 
Leapin’ lizards! Lest we forget... ImpactPlus can convert any scene to 
anaglyph stereo for viewing onscreen or on paper, using the supplied 
red-cyan glasses. For extra fun, try anaglyph animation! 
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♦  Text You Can (Almost) Touch 
Add unique dimension and motion to your message! Use 
WYSIWYG text entry to preview fonts and formatting, then edit 
each character as a 3D element... change color, position, tilt, and 
other properties... retype text at any time. Great for animation—
create spinning letters, exploding words, radical color shifts! 

♦  Texture You Can (Almost) Feel 
Decorate anything in the scene with a bitmap image for surface 
realism... grab texture presets from the Studio or define your 
own... include transparency for unique effects. Apply multiple 
texture components for added detail, environmental reflections, or 
hill-and-dale contouring. Easily rotate, resize, and move bitmap 
textures on any object. Switch planes and objects from solid to 
wireframe rendering, and apply flat or shaded colors and textures. 
Use vertex or table fog to add depth and drama. Animate 
textures... even use movie clips as textures, for a TV scene-within-
a-scene! 

♦  Create Your Own 3D Models 
Go beyond mere scene-building... step into the 3D Workshop and 
easily construct your own 3D objects using QuickShapes, simple 
drawing tools, or even imported clip art. The Workshop instantly 
converts your 2D figures to extruded or lathed 3D shapes! 

♦  Versatile Import and Export 
Choose the correct settings before export with the built-in Export 
preview window. ImpactPlus supports industry-standard 
formats—for animations and movies, you can export to .GIF or 
.AVI... even as a series of still frames! Choose .PNG to preserve 
32-bit transparent backgrounds. Output grayscale depth maps for 
advanced 3D effects in Serif PhotoPlus 8. Import standard 
metafiles, and for easy exchange, you can both import and export 
models in the DirectX™ (.X) format.  

♦  Serif Quality and Ease-of-Use 
ImpactPlus combines its own sophisticated 3D model format with 
built-in DirectX 8.1 support for rapid 3D rendering. MDI lets you 
open multiple 3D scenes at once. And of course, every detail of 
the UI is designed to support efficient, creative productivity. View 
and select lights, planes, and objects in the Navigator... check and 
control object and viewpoint coordinates in the Status panel... 
store your own custom models, lighting schemes, materials, 
backgrounds, and bevels in the Studio galleries. It’s all there at 
your fingertips!  
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 Registration, Upgrades, and Support 
If you see the Registration Wizard when you launch ImpactPlus, please 
take a moment to complete the registration process. Just call Serif toll-
free and provide the installation number and code shown. We’ll give 
you a personalized registration number in return. Remember, if you 
need technical support please contact us. We aim to provide fast, 
friendly service and knowledgeable help. 

 

Installation 

What you need to run ImpactPlus 
First of all, you’ll need a system that runs a recent version of Windows 
with adequate speed. If you need help installing Windows or setting up 
your printer, refer to Windows documentation and help (see below). 

♦  IBM compatible Pentium-class PC with CD-ROM drive and 
mouse (or other Microsoft compatible pointing device)  

♦  Microsoft Windows® 98, 98SE, Me, 2000, or XP operating 
system 

♦  32MB RAM (64MB for Windows 2000/XP) 

♦  50MB minimum free hard disk space 

♦  DirectX 6.1 (or higher) compatible 3D-accelerated SVGA 
graphics card (at 16-bit or higher color depth) 

♦  DirectX 8.1 supplied with ImpactPlus 

Additional disk resources and memory are required when editing large 
or complex documents. 
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What you need to know 
Don’t worry if you’ve never worked with 3D graphics software. 
ImpactPlus requires no special knowledge. Follow along on the 
Companion’s guided tours and you’ll be up to speed in no time. 

If you’re new to Windows computing, you will find it much easier if, 
before installing and using ImpactPlus, you spend a little time 
becoming familiar with the operating environment.  

� From the Windows desktop, click the Start button at the lower left 
and choose Help.  

First-time install 
To install Serif ImpactPlus, simply insert the CD-ROM into your CD-
ROM drive. The AutoRun feature automatically starts the Setup 
process. (If it doesn’t, follow the manual install procedure described 
below.) 

Just answer the on-screen questions to install the program. You will be 
given the choice between a Recommended install (which optimizes 
performance by loading speed-critical files to your hard drive for best 
performance) or a Custom install (which lets you specify the files you 
want copied to your hard drive). 

ImpactPlus Resource CD-ROM 
If you’ve purchased the Resource CD-ROM, we suggest you install it 
as soon as you’ve finished installing from the Program CD-ROM. 
Again, the AutoRun feature will automatically start the Setup when 
you insert the Resource CD-ROM into your drive. 

Manual install/re-install 
To re-install the software or to change any part of the installation at a 
later date, select Settings/Control Panel from the Windows Start 
menu and then click on the Add/Remove Programs icon. Make sure 
the correct CD-ROM is inserted into your CD-ROM drive and then 
simply follow the on-screen instructions. To install just one particular 
component to your hard drive, choose the Custom option and check 
only that component. 
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Starting ImpactPlus 
Once ImpactPlus has been installed, you’ll be ready to start. Setup 
adds a Serif ImpactPlus icon to the Programs submenu of the 
Windows Start menu. 

� Use the Windows Start menu to start ImpactPlus, or if ImpactPlus 
is already running choose New from the File menu. 

 

ImpactPlus launches and displays the Startup Wizard, with these 
options: 

♦  Use a Design Wizard lets you preview and select from a variety 
of instant effects, ready for you to customize or use “as is.”  

♦  Start from Scratch opens a blank scene window. 

♦  Open a Saved Scene lets you browse and open your own files. 

♦  View Samples displays a gallery of impressive ImpactPlus 
creations. 

If you’re just getting started with ImpactPlus, here’s a quick summary 
of learning paths you can follow: 

1 From the Startup Wizard, choose the Use a Design Wizard 
option. Then follow along with the Guided Tour below, “Instant 
Results.” 

2 For information about ImpactPlus tools and menus, just move the 
mouse pointer around the screen. Watch the HintLine at the 
bottom of the screen for capsule descriptions of each feature.  

3 Of course, read through the following Companion chapters for 
self-paced, hands-on tours of ImpactPlus tools and functions. 
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4 While there’s a lot of valuable info in the Companion, online help 
has it all! Choose ImpactPlus Help from the Help menu to see 
what’s available. The opening screen lets you browse the 
extensive Visual Reference, search the Index, or peruse the 
sequence of How To topics. Click Help on Help for some tips on 
how to proceed.  

5 If you’ve purchased the Resource CD-ROM, take a look at the 
wide range of Tutorials covering basic to advanced topics. 

Guided Tour: Instant Results 
Creating amazing 3D effects that you can be proud of is easy with 
ImpactPlus! The ImpactPlus window works like a miniature world, 
with its own objects that you can construct, manipulate, illuminate, 
and photograph from any angle. Take a single snapshot, and you’ve 
got a still image you can use in an illustration or on a Web page. Take 
a series of snaps, as the scene changes, and you can play them back to 
produce animations and video clips. Either way, it’s an intuitive and 
exciting way to get visual results! 

You can get started right away by selecting a built-in Design Wizard... 

� Run the Startup Wizard (File/New). 

If the Startup Wizard fails to appear, check Use Startup Wizard on 
the File/Preferences... screen, then try again. 

� From the Startup Wizard, click Use a Design Wizard. 

You’ll see the Wizard categories displayed on the left, with preview 
thumbnails on the right. You might take a few moments to explore the 
range of choices. (The actual number of Wizards depends on whether 
you’ve installed the Resource CD.) For this trial example, we’ll 
customize an instant 3D movie intro! 

� Open the Intros category and select the thumbnail for the Style 
Wizard, then click OK.  

The selected design appears as a new scene 
in the ImpactPlus window. Since this is an 
animated scene, we’re actually looking at 
the first frame of a series—that’s why the 
word “Presents” isn’t visible yet. But we 
can make significant changes to the scene 
right here on the first frame. Follow along 
carefully as we enhance several elements... 
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� Click the Backgrounds tab that’s part of the ImpactPlus Studio, 
at the far right side of the window. Scroll down in 
the list of categories and select Cosmic. Then click 
the very first thumbnail (“Cosmic 01”) in the 
gallery to add an instant sunset background to the 
scene.  

�  Over on the Tools toolbar at the left side of the window, the 
Move/Size tool should already be selected. Using its pointer 
cursor, double-click on “Your Text Films.”  

� In the dialog, replace “Your Text” with your own name (or some 
other word)... pick a different font if you like... and click OK. 

� Now drag the updated text block to the left of the sun. If it seems 
too big or small, you can resize it by dragging any node of the 
bounding box. 

 

Next, we’ll see how easy it is to add a 3D object to the scene! 

� Click the Studio’s Models tab and scroll down to the Sci-fi 
category. Click one of the futuristic flying machines; we’ve used 
“Space Jet,” first thumbnail in the fifth row. The 
new object appears at the center of the scene. (You 
can also drag model thumbnails into the scene to 
position them precisely.)  

�  Drag the jet object to the right of the sun, near the horizon. 
You may want to enlarge it a bit, and try using the Rotate tool 
(just below Move/Size) to give it a more dramatic angle. If you 
make a mistake, simply press Ctrl-Z to undo. 
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The jet looks a bit dark, so let’s give it some extra illumination. 

�  On the Lights toolbar at the lower left, click the Add Point 
Light button. This puts a new omnidirectional light source at the 
center of the scene and brightens the jet model considerably.  

 

�  If the jet now looks too bright, click the Intensity button with 
the Point Light selected and drag the slider to adjust the light. 

Now let’s try one method of adding some color. 

� With the Point Light still selected, click the Studio’s Attributes 
tab. In the Color/Transparency panel, the white swatch will be 
hilighted (since the light is initially white). Click any other swatch 
to change the hue and you’ll see the jet model respond 
accordingly. Keep trying colors until you find one you prefer. 

� Finally, in order to preview the scene unobstructed, right-click 
somewhere other than on an object (for example, in the sky) and 
uncheck Light Models. The model representing the Point Light 
will vanish, but its light will still shine. 
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Now let’s see how the revised scene looks when it’s animated. 

�  Locate the Animation toolbar, which should be onscreen in a 
small, separate window. (If it’s not visible, right-click and check 
Animation.) Then click the Play button.  

 

The animation plays once and stops on the last frame. This particular 
sequence consists of 20 frames, with one text object (“Presents”) 
changing its position over time.  

� To peek at what makes the animation happen, select the word 
“Presents” and then click the Animation toolbar’s  Maximize 
button to expand it. The two purple dots define the starting and 
ending position of the text object—that’s all there is to it! 

 

In Chapter 4, you’ll learn how easy it is to create your own animated 
effects. No doubt you’d like to make that jet zoom across the sky, too... 
but let’s not jump the gun. First, spend some time learning about 
scenes and objects in the next chapter, and soon enough you’ll be able 
to return to this example and confidently animate the fly-by. For now, 
just make sure your customized file is saved before moving on. 

�  Click the Save button (or choose Save from the File menu). 
Provide a name, and the scene will be saved in the ImpactPlus 
.IPP format. 

� If you’d care to view your results as an animated GIF or AVI 
movie, choose Export from the File menu, then select Animation 
and finally Image from the submenus. Select export options as 
desired (see Chapter 7 for details). 
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Video Setup Tips 
If you’ll be using ImpactPlus to create video clips—animated 
sequences to be inserted into existing video footage—then a bit of 
advance planning will go a long way. Because ImpactPlus clips must 
be tailored to suit your existing footage, it’s helpful to learn as much 
as you can on the video production side before you get started creating 
the clips. Consult the documentation accompanying your video editing 
software for clarification of any terms and procedures that may be 
unfamiliar. 

Here are some key points to consider: 

♦  Does your video editor support transparent overlays—and if so, 
what kind? ImpactPlus can export images with transparent 
backgrounds, using either a single color (as in “bluescreening”) or 
full 32-bit variable transparency. 

♦  Determine the frame size of the master video (for example 
320x240 pixels) beforehand, and use these same dimensions for 
your ImpactPlus scenes. File/Scene Setup... offers several 
standard video sizes, or you can set custom dimensions. Note that 
many video editors prefer frame measurements divisible by 8 or 
16. 

♦  Video frame rate is another consideration. While full-quality 
video may use 24 or 30 frames per second, rates of 12 to 18 fps 
are usually acceptable for computer viewing. But again, for 
seamless integration, the main thing is to match the frame rate 
you’re using in ImpactPlus to that of your master video. 

♦  When you export, you can choose whether or not to use one of the 
compression algorithms or codecs available on your computer. 
Our best general advice is to export your ImpactPlus AVIs using 
no compression (with (Use Codec unchecked). Since most 
codecs are “lossy” and will degrade the quality slightly with each 
save, a rule of thumb is to avoid compressing video segments 
more than once. Ideally, given enough disk storage space, you can 
keep your master video footage in uncompressed “raw” format 
through the entire editing process, then compress only at the final 
stage. When that time comes, plenty of information about the 
relative advantages of different codecs is available online. 
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Scene center 

It’s a 3D World... 
The best part of using ImpactPlus is that you can create terrific effects 
without having to master all sorts of spatial concepts and computer 
jargon. If you can grasp height, width, and depth, you’re halfway 
home! But learning any new program does involve a bit of trial and 
error. Here’s some background to help minimize the “error” part. 

The main ImpactPlus window consists of a frame (with titlebar, 
menus, etc.) enclosing at least one scene window. Imagine you’re 
behind a video camera, looking at a “set” with one or more objects 
positioned against a background. The ImpactPlus scene window is 
what you’d see through the camera’s viewfinder. As you’d expect, 
there are tools to let you rearrange the objects, substitute a different 
background image, or change the studio lighting for different effects. 
But that’s not all. With ImpactPlus, you can instantly change an 
object’s colors and dimensions, rotate it in space, apply cool surface 
textures, create your own mini-universes of text and shapes, create 
animation... and more! 

 

New objects appear at the scene center. From your viewpoint, looking 
through the scene window, you see the objects in perspective. You can 
reposition objects to be nearer or farther away (their sizes change 
accordingly), and freely move or point 
the “camera” anywhere with respect to 
the scene.  

You can also place lights of various 
types around the scene, and vary their 
color and intensity for different effects.  

Movable 
viewpoint 

Movable 
lights 

Background 

ImpactPlus 
scene window 

Scene 
objects 
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Each three-dimensional object takes up space in three directions, 
defined in 3D parlance as the X, Y, and Z axes.  

Think of the X axis as defining 
the object’s width or left-to-
right dimension, and the Y axis 
as defining its height or top-to-
bottom dimension. For example, 
the X and Y axes define the 
black character “a” in this text 
object.  

The Z axis defines the object’s 
depth or front-to-back 
dimension. It’s this extra 
dimension that gives us “3D.” 

Setting the view 
To set the width and height of the scene, choose Scene Setup... from 
the File menu, or right-click on an empty part of the scene window 
and choose Scene Setup.... Select a unit of measurement and enter the 
width and height. 

You can supplement the initial main window with optional secondary 
windows as needed. The main window can view the scene from any 
position or angle, shows fully shaded objects, and defines the final 
scene that will be printed or exported. Secondary windows, useful for 
checking and correcting object positions, are limited to a fixed 
viewpoint (such as Top or Right) looking straight into the scene 
center, and objects appear in wireframe mode. Both kinds of window 
initially provide a single light source for working illumination.  

 

For convenience, you can choose Layout from the View menu and 
select one of four basic window configurations. Main fits a single 
(main) window into the workspace; the other choices display a main 
window plus one, two, or three secondary windows. Or you can start 
with the one main window and open secondaries as needed—simply 

Main 
window 

Secondary 
window 

Z depth 

Y height 

X width 
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choose New Window from the Window menu, then select the desired 
starting view (Left, Right, Top, Bottom, Front, or Back) from the 
submenu. It’s possible to open any number of secondary windows, and 
drag or resize windows (or use the Tile command on the Window 
menu) to arrange the open windows. Note that you can’t open more 
than one main window. 

At normal view level (1:1 or 100%), the size of the scene window you 
see equals the size you’ve specified in Scene Setup. ImpactPlus gives 
you several ways of adjusting your working view without affecting the 
actual scene size: 

 To zoom in or out, choose the Zoom tool on the Tools toolbar, 
then left-click on the scene window to zoom in, or right-click to zoom 
out.  

 To adjust the scene window’s size to fit within the main window 
area, click the Zoom to Fit button on the Standard toolbar, or choose 
Zoom from the View menu (or the scene’s right-click menu) and 
select To Fit. 

 To restore the scene window to its actual size, click the Normal 
View (1:1) button on the Standard toolbar, or choose Zoom from the 
View menu (or the scene’s right-click menu) and select Normal View 
(1:1). 

Zoom to Fit and Normal View are also available on a handy menu if 
you right-click any neutral part of the scene. 

With this brief orientation, you’re ready to begin creating and 
manipulating objects in your own 3D scenes! So follow along as the 
rest of the chapter continues to explore the ImpactPlus interface. 
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Guided Tour: 3D Scenes 
ImpactPlus is so easy to use, with such compelling effects, that you’re 
sure to want to experiment on your own. The following guided tour 
will help you get up to speed, and very soon you’ll be pushing the 
limits of your creativity! We’ll use � checkbox bullets to mark the 
ongoing tutorial thread—steps we’d like you to complete as you follow 
along with the text. Save your work occasionally as you go along. 

The main purpose of this tour is to introduce you to the various 
ImpactPlus tools—not to make you an expert! For additional details on 
each tool and procedure, be sure to consult online help’s Visual 
Reference and How To sections. 

NOTE: If you have the ImpactPlus Resource CD-ROM, you can take 
the same tour by following the Learning Lab tutorial sequence... with 
the advantage of full-color illustrations and an onscreen format. 

Making a scene  
We’ll begin by creating a new, blank scene window. 

� Start ImpactPlus or, if it’s already running, choose New from the 
File menu, and select the “Start from Scratch” Wizard option.  

� Take a moment to identify the basic elements of the ImpactPlus 
interface: various toolbars, the Navigator, and the seven Studio 
tabs on the right. 

Your screen will look something like the illustration below. You may 
wish to resize the main window to bring the tools a bit closer to the 

scene window, and also click the Zoom to Fit button to 
maximize the working area.  

 

 

Studio 
Tools, Lights toolbars 

Animation toolbar 

Navigator 

Standard, Text toolbars 
Draw Style,  
Texture toolbars 
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We won’t be needing the Animation toolbar for some time, so we can 
hide it to free up some screen space. 

� Hide the Animation toolbar by clicking its  Close button.  

The lattice of blue lines in the center is the Bottom plane, one of six 
planes you can display as layout guides or scene elements. The Bottom 
plane slices through the scene center at the zero point of the scene’s Y 
(vertical) axis. Initially the main window’s viewpoint is elevated seven 
units above this plane, affording a perspective view.  

The Navigator window provides a hierarchical tree listing of all the 
planes, lights, and objects in a scene. You can easily reposition this 
central panel, and use it to select, rename, and manipulate any listed 
element. Let’s use it to hide the Bottom plane so the scene window is 
blank. 

� In the Navigator, click  to expand the Planes category. Click to 
uncheck the box next to the Bottom entry, and the plane 
disappears, leaving an empty window. You can collapse the 
Planes category before proceeding. 

The object of the exercise 
Adding 3D models, also called “objects,” to the scene is a snap! 

� Click the Studio’s Models tab to reveal the Basic Shapes 
category. Click the “Pyramid” shape (third row down in the 
middle). 

ImpactPlus imports the model and creates a new pyramid object at the 
scene center. (For future reference, you can also drag models from the 
Models tab and drop them at a specific position.) 

� In passing, note that the Navigator’s Objects category now 
contains a new entry, a “Pyramid - 3DW Object.” This default 
label simply means that this object was created in the ImpactPlus 
3D Workshop (as detailed in Chapter 6).  

If you want to relabel any Navigator item for more convenient 
identification, simply retype the label—here’s a simple demonstration: 

� In the Navigator, click the pyramid’s 
label twice to select the text, then 
delete the words after “Pyramid”.  

The pyramid, like all the basic shapes, has a white color by default, 
and no special texture or other attributes. Initially, what you see is an 
edge-on view, which is why the object now looks like a flat 
quadrilateral. Let’s prove that it really has three dimensions. 
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The right tool for the job 

�  With the pyramid object selected, click the button for the 
Rotate tool on the Tools toolbar at the left.  

Immediately, a spherical bounding box 
appears, with three orbital lines and nodes 
where the orbits intersect. Dragging a node 
makes the object rotate around one of its three 
internal axes.  

� Move the mouse pointer over the front 
node (watch for the special cursor), then 
drag it slightly to the left, then to the right, and you’ll see the 
object revolve. Release the mouse button, then click again on the 
front node and this time drag up and down. As the object revolves, 
its sides reflect the frontal lighting in different directions and 
begin to appear distinct from each other. Leave the object tilted in 
a different direction from where it started. 

When you drag a node, you can see the object revolve as if around a 
“spindle”. Each orbital line defines a rotational plane in relation to an 
internal axis, like the Earth’s equator in 
relation to its polar axis. Each object has three 
such internal axes: X, Y, and Z. These don’t 
change in relation to the object—in effect, no 
matter how each object twists and tumbles in 
space, it “remembers” its own top and bottom, 
front and back, right and left.  

Now consider the computer screen through which you’re viewing the 
scene: it too has its own axes defining top, bottom, and so on. We call 
these the scene axes. They’re fixed and unchanging, and quite 
independent of the objects in the scene itself.  

� With the pyramid still selected, hold down the Y key on the 
keyboard and you’ll see the object twist sideways. To reverse 
directions, press Y with the Shift key held down. Can you see how 
the object is rotating differently now?   

Using the X, Y, and Z keys with the Rotation tool (rather than 
dragging nodes) makes the object rotate around the scene axes. The 
pyramid’s internal Y axis passes through its apex, but it’s not 
revolving around that axis now! With the Y key held down, it revolves 
in a horizontal plane, around the scene’s vertical Y axis. 
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� Try rotating the pyramid, contrasting the drag and keyboard 
methods, until you can clearly visualize the difference between 
internal and scene axes.  

             Internal axes                         Scene axes 

 

Finally, let’s try some freeform rotation... 

� Click anywhere on the pyramid (but avoiding the nodes), and drag 
slightly. You’ll see the object respond as you “steer” it into a new 
position. Try using small circular motions to change orientation. 
Counter-clockwise motions will reverse clockwise changes, and 
vice versa.  

By the way, ImpactPlus features multiple levels of undo (which you 
can set in File/Preferences...)—so if you seem to have rotated your 
pyramid hopelessly out of alignment, you can always backtrack... But 
with a bit of practice, you’ll be able to use any of the three Rotation 
techniques to point objects unerringly in any direction!  

Let’s continue to explore the offerings on the Tools toolbar, using the 
pyramid as a sort of geometric guinea pig. The HintLine at the bottom 
of the ImpactPlus window provides Position, Size, and Angle 
information about each selected object, using an X, Y, Z format. Keep 
an eye on it as you proceed through the following steps. 

�  Click to select the Move/Size tool.  

As its name implies, this tool handles two functions. If you click 
directly on an object, you can drag it around along the scene’s X or Y 
axes. (Its distance from the viewpoint, or Z-distance, doesn’t change.) 
Alternatively, you can click one of the object’s nodes—the dots at the 
corners of the bounding box—and drag to resize it. (In this case, the 
object responds by growing or shrinking in three dimensions, although 
its center doesn’t move.) 

� Try moving and resizing the pyramid. Again, watch for the 
special cursor that appears when you’re over a node. 
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Before proceeding, let’s make life a bit more interesting by adding a 
second object to the scene—this time, a QuickShape. 

�  Click the little down arrow on the Insert QuickShape 
tool, near the middle of the Tools toolbar. (The actual button icon 
varies, depending on which shape you’ve selected most recently.) 
From the flyout menu that appears, choose the “Moon” shape. The 
cursor changes to a light bulb icon. 

� Click in the scene window and drag 
sideways with the light bulb cursor until a 
crescent shape appears and is roughly as big 
as the pyramid object. When you release the 
mouse button, you’ll see a slider.  

You can adjust the outline of any QuickShape by dragging its slider(s). 
In this case, the single slider varies the “phase” of the moon object. 

Experiment with the slider, leaving the moon as 
a typical thin crescent shape. Then double-click 
the shape to create the object. (Pressing Esc 
would cancel.)  

As with the pyramid earlier, the moon object 
initially appears in front view, and the 
Navigator includes a new entry (“QuickShape”) 
for it.  

� Use the Rotate tool to swivel the moon to a 
more interesting angle.  

� In the Navigator, relabel the QuickShape as “Moon.” 

 The next item on the Tools toolbar is the Stretch tool, which lets 
you adjust a single object’s size along one dimension at a time—for 
example, to make it thicker or thinner without changing its height or 
width. 

� Select the Stretch tool and click on the moon object.  

Again, you’ll see a bounding box; but this time it represents the 
internal axes of the object itself, as it’s currently positioned in space. 
Dragging the nodes to adjust width, height, and depth is intuitive.  

� Experiment with the tool until you get accustomed to the changes 
along each axis. Then return the moon to its original shape, more 
or less. 
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To choose: Press: 
Move/Size tool Ctrl+1 
Rotate tool Ctrl+2 
Stretch tool Ctrl+3 
Distance tool Ctrl+4 

� Choose the Move/Size tool and drag the 
moon down until it intersects the pyramid. 
Both objects are still centered the same 
distance from the viewpoint, so where 
they take up the same space, they overlap 
with intriguing results!  

 The Distance tool lets you move an object’s center along the 
scene’s Z axis—in other words move it closer to (or further from) the 
viewpoint. This complements the Move tool and lets you place one 
object in front of another in your scenes. 

� Choose the Distance tool and click on the moon object to select it. 
Now drag the object slightly down. Doing so decreases the Z-
distance and brings the object closer; dragging up pushes the 
object away. Although the object appears to grow or shrink, bear 
in mind that it hasn’t actually changed size—only position.  

TIP: In working with objects, you’ll 
often find yourself switching between 
the first four tools on the Tools 
toolbar.  
Use the shortcuts shown at right to 
jump quickly from one tool to 
another. 

You can select multiple objects by holding down the Shift key when 
selecting each object, or by dragging out a marquee around a group of 
objects. Grouping takes this one step further by combining separate 
objects into one composite object. You can move, resize, rotate, 
stretch, and perform other operations on a multiple selection or a 
group as if on a single object. Groups are handy because you can still 
select the individual component objects to make local adjustments as 
needed, and ungroup them if necessary. 

�  Try selecting both objects, then click the Group button on 
the Standard toolbar to combine them. Use the Move/Size tool to 
drag the combined object slightly.  

Take a glance at the Navigator and you’ll see that it now lists one 
“Group” object where it previously showed the two separate objects. 

�  Now click just the moon, and it acquires a red bounding box 
of its own. Drag the moon slightly and note that the pyramid 
doesn’t budge. Click on a blank part of the scene to deselect all 
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objects, then click either object—notice that they’re still grouped! 
Finally, click the Ungroup button to revert to two separate 
objects.  

Again, notice that the Navigator is keeping up with the changes. 

�  Moving right along, click the Text tool. Immediately, a text 
edit window pops up. Type a couple of words and pick a font from 
the drop-down list (we applied Stylistic SF to the words “Nile 
Style”). Click OK. 

The text you typed appears in the scene as 
a new text object (front view, of course.) 
The Navigator now includes a new 
“Text” object. 

� Use the four basic tools (Move/Size, 
Rotate, etc.) to adjust the text and 
place it in relation to the other 
objects.  

You can edit any text object by selecting 
it, then using the controls on the Standard 
toolbar to change font, alignment, and so on. To bring up the text edit 
window again, simply double-click the word object—then you can 
retype the text as needed. 

� In the Navigator, click the “+” sign next to the Text object to 
expand the item. You’ll see that each letter is also listed as a 
separate object. 

As the Navigator is showing us, text objects are groups consisting of 
separate letter-objects. That means you can edit single characters, too! 
The first time you click on a text object, the whole word or phrase is 
selected. Each subsequent click selects only the character under the 
tool. (To reselect the whole word, first click 
somewhere else to deselect it, then click the 
word again.) By selecting individual letters, 
you can adjust their position, color, or other 
attributes, which opens up a whole range of 
design options. For example, at right we’ve 
slightly enlarged and rotated the letter “N.” For details on working 
with text, see Chapter 5.  

� If you haven’t yet saved your work-in-progress, do so now using 
File/Save or the toolbar button.  
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Different viewpoints 
So far, we’ve covered tools that affect selected objects in the scene. 
The Tools toolbar also includes tools that let you alter the viewpoint, 
thus changing the appearance of the scene as a whole. Let’s take a 
quick look.  

� Click on a blank part of the scene to deselect all objects. Notice 
that the HintLine readout below the scene now shows values for 
the View.  

The current Position value is given as “0.0, 7.0”, meaning 7 units 
above the Bottom plane. This is the default starting viewpoint for new 
scenes, and we haven’t changed it since beginning the tour. 

�  Click the small down arrow on the Viewpoint button. A 
flyout menu appears, with seven choices. Move the cursor over the 
choices and you’ll see six of them are fixed viewpoint positions: 
Left, Right, Front, Back, Top, Bottom.  

� Click each of the preset buttons in turn and watch as the scene 
changes. As you do so, keep an eye on the HintLine readout.  

The HintLine values describe how far the viewpoint deviates from the 
straight-on Front view (which is “0,0” on the Bottom plane). If the 
viewpoint moves horizontally from this Front view, the first value 
changes; vertically, and the second value changes. (For more, consult 
the online help topic on the Viewpoint tool.) 

Don’t think you’re limited to just the six preset vantage points! In the 
main window, you can achieve unlimited “free orbit” viewpoint 
motion simply by dragging with the Viewpoint tool. (This option isn’t 
available in secondary windows, which only show fixed viewpoints.) 

� After clicking any of the fixed-
position buttons, move the mouse 
pointer over the scene window, then 
click and drag—up, down, left, 
right. You’ll see the view change 
continuously. 

� Experiment with various dragging 
motions until you begin to get a feel 
for manipulating the viewpoint.  

Conveniently, the Free button on the flyout “remembers” your last 
freeform setting. Let’s try it. 
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�  Click any of the fixed-position buttons on the flyout to 
restore a preset view. Then click the Free button on the flyout—
and the scene snaps back to your previous freeform viewpoint. 

�  Continuing down the toolbar, next choose the View 
Distance tool and drag up or down in the scene window. Again, 
the whole scene changes.  

Adjusting perspective with the View Distance tool can be useful for 
trimming (or adding) extra space around the edges of a scene. Note 
that unlike zooming in or out, this tool actually affects the final scene 
by altering how big objects appear in relation to the scene window. 

Note that the Distance value on the HintLine readout changes as you 
use the tool. This number is actually the Z-coordinate of the viewpoint 
position with respect to the scene center. (Imagine a “camera” at the 
viewpoint position, as in the illustration below.) To confirm this, let’s 
look at another way of setting object and viewpoint properties.  

� Click the Studio’s Attributes tab and then select the Status panel. 
Under View, locate the set of controls for Position. 

� Try the View Distance tool again 
and you’ll see the Z value for view 
position changing, in accordance 
with the HintLine’s Distance value. 
Now click the arrows for the Z 
control—and the viewpoint changes 
just as if you were using the View 
Distance tool.  

The Status panel serves as a sort of interactive HintLine, allowing you 
to fine-tune object and view properties using the same X, Y, and Z 
values. Most of the controls duplicate the tools we’ve already 
explored—but one adjustment is unique.  

� Click the “up” arrow next to the first (X) control for the 
View/Angle adjustment. You’ll see the scene objects appear to 
move upward. Click the “down” arrow to reverse the change. 

The View Angle control works like the Rotate tool—only here, it 
affects the tilt of our imaginary camera, as in the illustration. 
Changing the X, Y, or Z values pivots the camera around the 
respective axis. 
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� Try adjusting  the Y and Z controls to 
get a feel for how changing the 
viewpoint angle changes the view. It’s 
important to realize that the scene 
objects aren’t moving—only your 
viewpoint is changing! 

TIP: After changing the view angle, you 
can still move the viewpoint freely while 
maintaining the custom angle. Click the 
Viewpoint button, then hold down the Shift key while dragging in the 
scene window.  

Note that in normal use, the Viewpoint tool affects the view angle as 
well as the view position, because the “camera” must keep twisting to 
stay pointed at scene center. 

� If you want to restore the starting camera angle, enter “5.0, 0.0, 
0.0” as the values. 

In the material world 
Up to this point, we’ve been content to leave all the objects in the 
scene in their original, rather pallid condition. And in fact, we’ve got a 
nice grayscale composition going. But before concluding the tour, let’s 
liven things up a bit.  

� Select the Studio’s Attributes tab and display its 
Color/Transparency panel. 

In ImpactPlus, as in the real world, a number of factors determine how 
an object appears. Besides color, an object’s material (surface) 
properties include texture, transparency, and shine. Lighting makes 
a big difference, too—what looks like a blue moon may actually be a 
white moon illuminated by a blue light (or something else entirely)!  

The four buttons at the top of the 
Color/Transparency panel let you 
control the interaction of light and 
surface color components. This interaction can get fairly complicated, 
and we’ll postpone detailed coverage until Chapter 5. For now, we’ll 
stick with the currently selected Base setting. This is the major 
component in any event—basically it’s what we mean when we loosely 
refer to the “color” of an object or light source. More technically, an 
object’s Base color setting determines how the object reflects the Base 
component of any light that hits it. 
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� Using any of the basic tools, select the moon object. Over in the 
Studio’s color table, you’ll notice that the white swatch is selected, 
indicating the moon’s Base color is white.  

� Now click any other color swatch, and then click several others to 
see what happens. 

As you might expect, with each click the moon changes color. 

� Drag the Transparency slider at the bottom of the Studio to see 
the moon fade to nothingness. Slide it back to leave the object 
fully visible when you’re done. 

� Now click the pyramid object to select it, and change its color to 
green. Then display the Studio’s Materials tab.  

Like the Models tab (and all the Studio tabs apart from Attributes), the 
Materials tab stores a wide variety of presets you can apply to your 3D 
creations. As mentioned above, each material preset combines 
information about color, texture, transparency, and shine.  

� Scroll down in the list of categories and 
expand the Patterns section. Click the first 
entry (the red-checked “Pattern01”).  

The green color on the pyramid gives way to the 
red-and-white pattern because the preset’s 
material attributes superseded those previously defined for the object. 
If you’ve applied a preset and then want to adjust an individual 
attribute, just use the Attributes tab. 

� As a very brief detour, right-click in the Studio gallery and notice 
the item Add from Selection—a command that lets you store 
your own custom materials here. The same menu affords other 
choices, like loading a DirectX (.X) file, or creating/editing 
gallery categories. It’s sure to come in handy later on! 

� Display the Attributes tab’s Color/Transparency panel, and 
again click the green color swatch.  

The checked texture remains, but now you’ve 
changed the object’s Base color, creating a 
new material. Using this approach, it’s easy 
to start with a Studio preset and custom-
design your own effects... and then (as just 
noted) store them in the Studio for later use.  
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Shedding light on the situation 
Taken together, all the lights used in a scene are known as the scene’s 
lighting scheme.  

� In the Navigator, expand the Lights 
category and then the Basic Lights 
subcategory.  

Each new scene begins with a single Main 
light switched on in the main window, and a Secondary light in each 
secondary window. These window lights are fixed at the viewpoint in 
each window, providing working light so the scene isn’t dark to start 
with. 

� Uncheck the Main Light item. The scene goes dark since it has 
lost its only source of illumination. Check the item again. 

�  Now click the Back button on the Viewpoint flyout. Notice 
that the scene is still evenly illuminated, since the Main light is 
now shining from the back. Return to the original viewpoint. 

If all you want is straight-on, flat lighting in your scene, the Main 
light may suffice—but for adding depth, shadows, and subtlety, you 
have plenty of other lighting options. ImpactPlus provides four 
different types of light sources (Ambient, Distant, Point, and Spot) 
that you can mix and match in any number or combination. The 
Ambient light is included in each new scene, but switched off to start 
with; the others you can add one by one as needed.  

Although each type of light has its own special properties—detailed in 
online help—one thing they have in common is the ability to take on a 
particular color. You can use multiple lights of different colors, in 
different positions, to create nuanced interactions with the base colors 
of scene objects. And you can even produce animations where lights 
move or change color between frames. 

To get a feel for how the lights work, let’s take a closer look.  

� Select the Main light by clicking its entry in the Navigator.  

� Display the Attributes tab’s Color/Transparency panel. Notice 
that white is selected as the light’s Base component (with the 
Glow and Ambient components grayed out). Click the yellow 
color swatch. 
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The scene objects change color completely as they’re bathed in a vivid 
yellow hue. The actual changes you see will depend on the Base colors 
of individual objects.  

To review: Light sources produce light, and objects reflect light. What 
we’ve done is alter the Base component of the Main light from white 
to yellow. Each scene object’s Base component determines how it 
reflects the yellow wavelengths. If you previously set your moon to a 
blue Base color, for example, it should now appear quite dark because 
it can’t reflect the yellow: blue and yellow are complementary. With 
just one light source, the interaction of lighting and object colors won’t 
get much simpler than this! (We’ll return to the various other 
components in Chapter 5.) 

�  Locate the Lights toolbar on the left side of the screen. 
Click the Intensity button and then drag the slider to the left. 
You’ll see the scene fade as the Main light’s output dims. (If 
nothing happens, you need to reselect the light in the Navigator.)  

� Now switch off the Main light completely by unchecking it in the 
Navigator. The scene goes dark for the time being.  

�  Just above the Intensity button, 
click the Add Spotlight button. 
You’ll see a new object, a model 
representing a spotlight, appear 
between your viewpoint and the scene 
center. In the Navigator, a new item 
(“Spotlight”) appears.  

The non-basic lights (spotlights, point 
lights, and distant lights) all appear as models in the scene. You can 
click on the models directly or use the Navigator to select them, and 
the basic tools to reposition them. 

� Use the Move/Size tool to drag the 
spotlight model around. Seen in profile, 
the model actually resembles a 
flashlight or torch—and the effect is 
exactly like shining one around in the 
dark. As it moves, it remains pointed 
forward, casting a pool of light ahead.  

� Use the Rotate tool to swivel the light 
around so it points in different 
directions. Leave it pointing more or less straight ahead. 
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Now let’s look at a couple of ways of varying the spotlight beam. 

�  Move the spotlight to the center of the frame, then choose 
the Distance tool and drag downward on the model. (As with any 
selected object, you can track the model’s Z-position on the 
HintLine or the Status panel.) As the spotlight moves toward you, 
its beam widens to illuminate all three objects. Drag up, and the 
spotlight gets closer to the objects, with a tighter beam. Leave it 
about where it started (Z = -20).  

�  Now click the Falloff button on the Lights toolbar and 
experiment with the slider. This lets you adjust the beam’s width 
without altering the light’s position in space.  

As with the Main light, you can use the Intensity slider to change the 
beam’s brightness, and the Studio to alter the color components of the 
light source. 

� To change the Base color of the spotlight beam, click a different 
color swatch on the Color/Transparency panel. Note that using a 
lighter or darker shade of a color is another way of altering the 
light’s brightness. 

Now that you’re an expert on manipulating spotlights, you might try 
switching the Main light back on and varying its 
intensity in relation to the position and intensity of 
the spotlight. 

Also on the Lights toolbar, you’ll find buttons for 
adding point lights and distant lights. Each of 
these has its own special properties, which you can 
investigate at your leisure. We suggest you 
continue the same approach: turn off everything 
but the one light and then just experiment. (For 
details on each light type, search for “lights” in the 
online help index.)  

In the meantime, don’t overlook the Studio’s Lights tab—well 
stocked with preset lighting schemes arranged into convenient 
categories. Another great way to experiment with lighting is simply to 
apply a preset, inspect the Navigator to see which lights have been 
included, and then customize the settings for best effect. As with 
materials, right-clicking in a Lights gallery gives you the option (Add 
from Scene) of saving the current scheme for later use.  
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TIP: If you find that the light models in a scene are getting in the way 
of working on objects, uncheck Light Models on the View menu. This 
doesn’t switch the lights off—it only hides their models—so you’ll 
still be able to select and adjust light properties via the Navigator. 

� Before we move on, save your scene as an .IPP file—perhaps 
using a different file name if you’ve made major changes since the 
last save. 

The plane truth 
To end this guided tour, let’s return to planes—the last of the three 
main sections of the Navigator—which we’ve only briefly mentioned 
so far. To simplify things, we’ll start with a blank scene. If you’ve 
already got an open scene, you can close it (although ImpactPlus does 
let you work with more than one open document). 

� Choose New from the File menu and select 
the Start From Scratch option. 

� In the Navigator, expand the Planes group.  

The six planes listed are surfaces that function 
like the walls of a “virtual room” within the scene. 
You can use these planes simply as visualization 
aids, or include them as part of the final scene. 
Let’s see how to use the Studio and toolbars to apply colors, textures, 
and shadows to planes. 

As before, the new scene has a visible Bottom plane slicing through 
the scene center.  

� In the Navigator, switch on the Back and Left planes by checking 
them in the list.  

Now the scene shows three planes that meet at a corner. (For a slightly 
wider view, you can use the Distance tool to zoom back.) 

� On the Studio’s Models tab, open the Basic Shapes category and 
click the “Torus Knot” thumbnail to bring a new object into the 
scene.  

� Check the object’s position on the HintLine or Status panel, and 
make sure it’s at “0, 0, 0.” 
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� Choose the Viewpoint tool and drag 
randomly in Free Orbit mode to get a 
better sense of how the planes define a 
space within the scene, and where the 
scene center is located. Don’t forget, you 
can hold down the Shift key to change 
view position without changing view 
angle. In the illustration, we’ve shifted 
the viewpoint to the right of center, and 
angled up.  

ImpactPlus uses consistent X, Y, and Z units to describe position, size, 
and distance. For example, the Main viewpoint is initially 80 units in 
front of the scene center (0, 0, -80). New lights appear 20 units in 
front of center. And by default, each plane is initially a square of 40 
units per side, with smaller 5x5 grid squares.  
TIP: Using the File/Preferences... dialog, you can change the size of 
the scene planes (and the default setting, if desired) by changing the 
“Extent” setting. To make the grid squares larger or smaller, adjust the 
“Grid Size” setting.  

Planes are square slabs fixed in space, but they behave in many 
respects like regular objects—for example, the way they respond to 
scene lighting.  

�  Click on the Back plane or select it 
in the Navigator. Locate the Draw Style 
toolbar and click the Solid button. The 
plane changes from a wireframe grid to 
a solid surface. Repeat these steps for 
the Bottom and Left planes.  

� Drag the torus up so it’s floating in the space enclosed by the 
three planes, and zoom in on it. 

�  With the torus selected, click the Flat button on the Draw 
Style toolbar.  

The rounded contours of the torus take on a banded appearance (see 
illustration), with the “bands” apparently made up of trapezoidal 
shapes. In fact, they’re subdivided even further!  

�  Click the Wireframe button.  
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 Solid - Shaded Solid - Flat Wireframe 

In Wireframe draw style, you can see that the “exoskeleton” of the 
torus is actually made up of of triangular facets—the building blocks 
of all ImpactPlus objects. To make an object appear solid, its facets are 
filled in one of two ways. In Shaded fill mode, each facet receives a 
complex gradient fill calculated from all three corners of the triangle, 
yielding a smooth, continuous surface. In Flat mode each facet takes a 
solid fill, an average of the three corner values. Flat-filled surfaces 
(like the torus in the middle) appear discontinuous, clearly composed 
of lots of separate surfaces. The difference between the two fill modes 
will be more apparent on some objects than others, and also depends 
on the properties of the light hitting the surface. 

Like objects, planes can take either fill mode. 

� Try switching one or more of the planes to Flat fill mode. Since 
planes are technically objects with just two facets, you may see a 
Flat plane appear as two distinct solid triangles!  

�   Switch all three planes and the torus back to Solid draw 
style and Shaded fill mode before proceeding. 

Besides changing its fill mode, you can change a plane’s material 
properties (color, texture, etc.) as easily as you can those of a regular 
object. 

� With the Back plane selected, click the Studio’s Materials tab, 
open the “Marble” category, and click any texture thumbnail.  

Shadows are one aspect of lighting we haven’t touched on, and they’re 
easy to demonstrate with this setup. By default, lights don’t cast 
shadows—but you can switch the property on for any light to produce 
a desired effect. 
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�  On the Lights toolbar, click the Add Spotlight button. Drag 
the new spotlight to the left side of the scene, above the midline. 
To accentuate its effect, tilt it toward the torus with the Rotate 
tool, and widen its beam by dragging the Falloff slider to the 
right. With proper positioning, you should be able to illuminate 
the torus and Bottom plane fully. 

       

�  With the spotlight selected, click the Shadows On/Off 
button (on the Lights toolbar) so it’s down. 

Now the torus object casts a pretzel-shaped shadow.  

� With the Move/Size tool, drag the object up and around for more 
dramatic results. You might also try adding one or more new 
lights to the scene to experiment with shadow effects.  

� To add a finishing touch to this rather surrealistic scene, display 
the Studio’s Backgrounds tab and expand the “Cosmic” category. 
Click any thumbnail... and use your imagination! 
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That completes this survey of the ImpactPlus scene window and its 
basic tool set. Everything we’ve touched upon is covered in greater 
depth in online help—but you already know more than enough to 
continue experimenting on your own. We’ll pick up with more 
advanced concepts, tools, and techniques in Chapter 6. But if 
transforming static scenes into motion sequences and video clips is 
your goal... just continue straight on as we explore the powerful 
Animation toolbar. 
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Animation Basics 
Producing animation with ImpactPlus is like having your own multi-
camera movie studio in a shoebox. As the director, you have complete 
control over this world. And if you’ve been following along in the 
Companion so far, you know enough already to begin making 
movies... with just a bit more theory and hands-on training. 

ImpactPlus animations are fundamentally static scenes, with the 
animation added as an “overlay”—in the form of variations stored as 
frames. (We’ll explain more about these in a moment.) If you’ve 
previewed the ImpactPlus Samples and Design Wizards, you’ve 
probably noticed that some are animated, and some aren’t. In Chapter 
2’s “Instant Results” tour, we took an animated Wizard scene and 
customized several of its static elements without affecting the 
animated playback.  

The Studio’s Animations tab provides yet another demonstration that 
animation works like an “overlay.” It stores lots of preset animation 
sequences that you can simply click to apply to any selected object or 
light model. To play back the results, you’ll need the Animation 
toolbar. We introduced this in Chapter 2, and now it’s time to take a 
closer look.  

To display the Animation toolbar if it’s not already visible, check 
Animation on the View menu. This 
toolbar has two states. In its compact form, 
it consists of a basic Control Panel for 
playing back animations (shown at right).  

The first set of three buttons in the Control Panel are Play, Stop, and 
Pause. Use these to preview the animation directly in the scene 
window. The second set of buttons set the playback mode. Click 
Single Run to play the sequence once, stopping on the last frame. The 
next button, Ping Pong, plays the sequence indefinitely—first 
forward, then backward. Finally, the Loop button also sets up an 
endless repeat condition, this time repeating from the first frame each 
time.  

To expand the toolbar, click its  Maximize button. This displays an 
Edit Panel that lets you edit existing animations or create new ones.  

Note that you can drag the toolbar outside the ImpactPlus window to 
increase the available workspace. The toolbar automatically docks in 
certain positions; to keep it floating anywhere onscreen, hold down the 
Ctrl key when you drag the bar. 
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In order to use create animations or video clips for your Web pages, 
presentations, or movies, you’ll need to export it to a standard format 
known as animated GIF or to the Windows .AVI movie format. 
Options that you set using the Animation toolbar, such as playback 
mode and speed, are incorporated into the animation when it’s 
converted to a GIF or AVI. 

To understand how animation works in ImpactPlus, consider a basic 
3D scene with several objects. Instead of pointing a still camera at the 
scene, imagine we’re using a movie camera that lets us expose one 
frame at a time. Between each exposure, we can adjust one or more of 
the scene objects (which may include objects, text, or lights) in various 
ways. We might change an object’s position over time, so that it 
appeared to move from one side of the scene to the other. Or we might 
change its rotation angle, so that a sphere appeared to spin on its axis. 
Once we’ve shot a series of frames, we can play them back rapidly and 
see the motion unfold.  

Creating animation in ImpactPlus is a fast and flexible process. In 
general, you first decide how many frames you want in the sequence. 
Then you issue instructions to the scene objects, telling them how to 
behave during the sequence. Naturally, each object that will change 
needs its own set of instructions. For each such object, you’ll specify 
which properties need to vary, and define several key frames that 
show the object exactly as you want it to appear at that point in the 
sequence. ImpactPlus takes care of the rest: it examines the key frames 
and automatically generates “in-between” frames that take care of the 
transformations. The result is a seamless animation. 

For each object, you can set key frames for Position, Size, Rotation, 
Texture, Color, Transparency, Shine, and Deformation. For the 
scene as a whole, you can set key frames for the background property 
Fog. Take a moment to think about the movements that could result 
from varying each property: zooms and pans, pinwheels, flying planes, 
planetary orbits, appearing and disappearing shapes, leaping lizards 
emerging from the mist, shifting lights and shadows, exploding text! 
To get started, try the following mini-lesson. 
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Guided Tour: 3D Animation 
Follow along with this step-by-step example and create a rotating 
globe! 

Around the world in 20 frames 
� Choose New from the File menu (choose the “Start from Scratch” 

Wizard option) to start with a new, blank scene. If the any planes 
are visible, hide them using the Navigator. 

� Click the Studio’s Models tab and select the 
“Planets” category. Click the “Earth” model’s 
thumbnail and a globe object will appear in the 
center of the scene, complete with seas and 
continents. The African continent takes up 
most of the right half of the globe. 

� Show the Animation toolbar (using View/Toolbars) if it’s not 
already visible. Click the  Maximize button if necessary to 
reveal the extended Edit Panel. 

The controls along the bottom of the Edit Panel, and the property 
matrix above, provide feedback on the current animation. Note that the 
Length box is showing there are 20 frames in the sequence (the default 
value), and that the cells for frames 01 through 20 are accordingly 
shaded green in the matrix; beyond that, they’re gray. The Current 
box shows we’re looking at frame 1, and “01” column is highlighted. 
To the left of the property matrix, you can see various properties listed, 
each with its own button. These will all be much less mysterious in a 
moment. 

� With the Move/Size tool, deselect the Earth 
by clicking in an empty part of the scene 
window, and now in the properties list you’ll 
see that only the last property (Fog) is 
enabled. That’s because it applies to the 
scene as a whole, regardless of what’s 
selected. 

� Now select the Earth object again, and all the 
other object-specific properties become 
available, as at right.  



Making It Move    45 

 

 

Let’s create some key frames that will tell the Earth how to rotate. In 
order to generate a convincing full-cycle rotation, ImpactPlus needs us 
to provide several snapshots of what the Earth should look like at key 
positions in the cycle. So let’s proceed to define our key frames: a 
starting and ending view, and a couple of intermediate views.  

�  The only property we need to include in the 
animation is rotation, so click the  button next to 
Rotation and it changes to , showing this property is now 
included. 

� Click in the cell adjacent to Rotation in the frame “01” column. A  
 key frame marker immediately appears in the cell. This records 

the object’s starting (frame 1) rotational value. 

� Next we want to jump about a third of the way along the 20-frame 
sequence, so click the number “08” at the top of the matrix, or 
right-click in frame 8’s column and choose View Frame. You’ll 
see the Current box update to show we’re on frame 8. We’ll create 
a key frame for the first intermediate view here. 

 

� Choose the Rotate tool. Click on the central node and drag it 
right (along the equator) to rotate the Earth until the east coast of 
South America is just disappearing over the 
horizon (on the HintLine “object angle” readout, 
a Y value of about -75º). You may need to drag 
twice. When you release the button after 
dragging, ImpactPlus inserts an automatic key 
frame marker at frame 8 for the Rotation 
property. 

Note that ImpactPlus intelligently defines a new key frame each time 
you adjust one of the object properties you’ve checked to include in the 
animation. You can also use the Status panel of the Studio’s Attributes 
tab to enter object coordinates directly.  

� Now select frame 15. To create the second 
intermediate view, drag right on the central node 
until Australia is centered in the view  (Y value 
of about 45º on the HintLine). Again, a key 
frame marker appears.  
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� For the end frame of the sequence, the Earth should be rotated 
nearly all the way around, just short of its starting position. Jump 
to frame 20. The scene will still look as it did in frame 15. 

� Drag right on the central node to continue the 
Earth’s rotation. Watch the HintLine and stop 
rotating when the Y value is about 20º. A fourth 
key frame marker appears in the frame 20 
column. 

� Now click the  Play button and you’ll see the Earth rotate!  

To make it rotate continuously, click the  Loop button. 

Congratulations! You’ve just made the Earth move. And now for a 
shortcut. Completing the above sequence will give you a valuable first-
hand feel for animating an object from scratch... but in this case 
there’s an easier way to get an object to rotate.  

� Start with a new globe object, then simply look on the Studio’s 
Animations tab, locate the Spins gallery, and apply the “Y Axis 
Rotated Counter-Clockwise” effect! 

NOTE: To take your spinning globe another few steps further and 
convert it into a video clip intro, spin up your ImpactPlus Resource 
CD-ROM and check out the tutorial titled “Out of This World”!  

Editing Animations 
If you’ve just completed the mini-lesson above, want to customize a 
Design Wizard, or have even created an animation of your own, the 
Edit Panel on the Animation toolbar will show the key frames defined 
for each object in the scene. If there’s more than one object, you’ll 
need to click each one individually to see its key frames. Note that 
animations will often include static objects that don’t move at all 
during the sequence. 

It’s easy to edit animations by adding new objects to the scene (with or 
without movement), replacing Wizard text with your own, and so on. 
Here are some additional pointers on working with the Animation 
toolbar: 

♦  The easiest way to remove animation from an object is simply to 
select the object, then uncheck all the “included” properties on the 
Animation toolbar. Of course, if you’ve just applied the effect as a 
preset, you can simply use Undo. 
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♦  You can click on any frame number, or right-click in its column 
and choose View Frame, to jump to that frame. 

♦  For a rapid preview, drag back and forth across the row of frame 
numbers or use the Current box spin arrows. 

♦  If a particular object transformation appears jerky, first determine 
which property and key frame seem to be the source of the 
problem. Then go to that key frame and either: 
�  Adjust the object property itself or  
�  Move the key frame marker slightly (e.g. drag it left or right a 
frame at a time).  
Moving two key frames closer together has the effect of speeding 
up the transformation between them; moving them apart slows 
things down. 

♦  To change the overall playback speed, type a new value into the 
Speed box and press Enter. The playback rate in ImpactPlus may 
not match the frame-per-second rate shown in the box. That value 
will only be applied when the animation is exported. To determine 
an optimal rate setting, always preview the exported file in a 
browser or suitable editing program. 

♦  To change the number of frames in the sequence, simply type a 
new value into the Length box and press Enter (but see the 
following paragraph). Frames are added or subtracted at the end 
of the sequence. In general, the exported file will be more compact 
if it has fewer frames. There’s nothing sacred about the default 
length of 20 frames. Many convincing animations can be 
accomplished in 10 frames or less.  

♦  Be careful if adding or subtracting frames after you’ve defined key 
frames. Obviously, the resulting sequence won’t have the same 
number of frames—and there’s no undo for this action—so decide 
beforehand what you want ImpactPlus to do with the existing key 
frames.  
� To preserve the current relative distribution of key frames 
between the first and last frames, keep the Adjust Key Frame 
Spread box checked. For example, if you had a 12-frame 
sequence with key frames on 1, 6, and 12, and increased the 
Length to 20 with the adjustment option checked, the resulting 
key frames would be placed at 1, 10, and 20. 
� Uncheck the box to leave existing key frames exactly where they 
are. Using the same example, lengthening the sequence form 12 to 
20 frames would leave the key frames at 1, 6, and 12. This would 
be useful if you planned to add add more motion to the end of the 
existing sequence. But note that if you shortened the same 
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sequence to 10 frames without adjusting the spread, you’d delete 
the key frame at frame 12. 

♦  If you import a GIF, MPG, or AVI movie as a texture component 
(as described in Chapter 5), note that ImpactPlus fits the movie to 
the duration of the scene’s animation (i.e. its Length times Speed). 
For example, a 25-frame animation at 10 frames per second has a 
duration of 2.5 seconds. If you import a 3-second movie as a 
texture, ImpactPlus will lop off its last half second. If the movie is 
too short, on the other hand, ImpactPlus loops it as needed. If you 
need to sync the two, adjust the animation’s Length and/or Speed 
values prior to importing the movie. Also, note that movie texture 
playback is independent of property matrix or key frame settings. 
Finally, if an imported movie uses variable frame rate settings, 
ImpactPlus uses only the initial frame rate to determine the 
duration.  

 

Producing Video Clips 
So far in this chapter, we’ve covered the basic animation techniques 
with which you can produce standalone animated GIFs or AVIs for 
presentations, Web sites, personal messages and the like. You can use 
these same techniques, then simply export to the .AVI format, to 
create video clips to be integrated with existing video material for 
home or business presentations. For some great ideas to get you 
started, take a look at the ImpactPlus Design Wizards! 

ImpactPlus lets you improve upon the relatively limited special effects 
available in standard video editing programs. What you can achieve 
technically will still depend in part on the versatility of your video 
editor—but the key creative question will always be: Where could your 
master video stand improvement? In particular, think about how you 
might keep your audience more engaged by using 3D text and graphics 
for video elements such as... 

Intros. What they say about “first impressions” 
certainly holds true in video! For home 
audiences, simply having an intro will hook your 
viewers... while for more demanding audiences or 
clients it’s a chance to put professionalism up 
front. Perhaps an animated logo, a simple movie 
title with nice lighting effects, or an atmosphere-
building cinematic sequence... whatever your 
choice, try to set the tone for the overall presentation.  
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Credits. Keep your audience captivated through 
the final frame by livening things up at the end! 
Scrolling credits are just as easy to create as a 
spinning logo... consider running them over 
outtake or “blooper” footage. Enhance your home 
movie by introducing the cameraperson and 
director, the subject, even the stars.  

Titles and transitions. A picture may be worth a 
thousand words, but as digital video and Web 
media converge, text is more important than 
ever! Whether you cut to separate “title cards” as 
in the silent-movie era, employ blends or overlays 
(with or without animation), or simulate TV 
adverts... high-quality onscreen text can enhance 
any production.  

Pre-production planning 
The most useful planning you can do will be creative thinking. 
Animation has its own language—based on motion and change—and 
employing it fluently will guarantee greater impact in your video 
presentations. You can use surprise, humor, font psychology, character 
actions, color change, all manner of lighting and spatial transitions. 

Reality intrudes, however. When you’re producing clips to supplement 
existing digital video footage, you’ll need to work backwards from that 
master video to determine what settings to use in ImpactPlus. So your 
creativity needs to be informed by knowledge of the particular video 
editing program (“editor”) you’re using. Its capabilities will largely 
determine how ambitious you can get—but remember, creativity will 
help you find a way around built-in limitations! 

The type of video editor you’re using will make a difference. Most 
video editors provide a storyboard-style or time line interface where 
each video clip is represented by an image, and you can use drag-and-
drop to assemble and rearrange the clips. If you’re just starting out, 
begin with a few small-scale experiments involving just several video 
clips. Make sure you’re familiar with the mechanics of the process 
before tackling a larger production. 
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Other programs are frame-based and deal with AVI video content as 
a series of separate graphic images. In this kind of environment you 
can edit individual frames, insert new single frames, and sometimes 
import a range of frames either as an insert or an overlay on existing 
frames. ImpactPlus provides the Export>Animation Stills option to 
accommodate this method of video editing.  

If your editor supports transitions or blends between clips, consider 
whether you’ll want to use these with your ImpactPlus sequences. If 
so, you’ll need to pad the ImpactPlus footage with leading and/or 
trailing frames where “nothing happens”—allowing time for the blend 
to occur without detracting from more important action. Since adding 
even one second of animation (at, say, 30 frames per second) comes at 
the cost of longer export time, it’s a good idea to leave adding the filler 
frames until the final export, after you’re satisfied with the creative 
portion. 

A whole new range of possibilities opens up if your video editor 
supports multi-track or overlay effects. Multi-tracking or mixing 
means that two (or more) video clips can be laid down concurrently 
and combined in creative ways. Some editors allow multi-tracking but 
only display the uppermost or overlay track. You may have the option 
of removing a single solid color from an overlay track, creating a 
composite for titling or background effects similar to the “blue-
screening” used in movie and TV studios. 

Frame-based editors may be able to accomplish overlay by importing 
frames that are already transparent. ImpactPlus can export animation 
stills with transparent backgrounds to suit this approach. The .GIF 
format supports one level of transparency (the single background color 
you designate will drop out), while the 32-bit .PNG format uses an 
alpha channel to preserve variable or in-between levels of 
transparency. 

When planning your production, bear in mind that ImpactPlus outputs 
video clips without audio. Assuming your master video includes 
sound, find out how your video editor will allow you to deal with the 
resulting dropouts. For example, you may be able to insert the new 
video over an existing audio track, mix in new audio creatively over 
the ImpactPlus sections, or even stretch an existing audio track over 
the silent footage. 
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Production checklist 
If you’re just setting out to produce ImpactPlus video clips, here’s a 
quick recap of the steps involved: 

1 Find out as much as you can about the capabilities of your video 
editor (see the preceding section). Plan how you’ll integrate 
ImpactPlus clips with existing master video, and collect basic 
information about relevant technical details like frame size, frame 
rate, and format. (Review the “Video Setup Tips” in Chapter 2.) 
Run some tests before you tackle a major production! 

No matter how simple your concept, sketch a storyboard on paper 
for each ImpactPlus sequence you plan to produce. If you’re 
preparing more than one clip, decide in advance on design 
elements that will lend consistency to the production.  

2 Set up each ImpactPlus scene using suitable dimensions and 
background. 

3 Add models and text objects, then set up scene lighting. Refine 
details like texture and bevel until the static scene looks right. 
Save custom elements as presets so you can reuse them in other 
scenes. 

4 Calculate the clip’s duration and frame rate based on the demands 
of your master video, and add animation frames as needed. Then 
go to work defining key frames for each element that will change 
over time.   

5 Export periodically (uncompressed .AVI format recommended) 
and test video clip playback, making adjustments in ImpactPlus as 
needed. Try importing a clip into your video editor to confirm 
technical details. 

6 Once you’ve found the right formula and approach, stick with it 
as you produce the rest of the clips you’ll need! 
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Creative Tips 
There’s no disguising the fact that Serif’s creative team have had a 
field day with ImpactPlus! The Samples supplied with the basic 
program and the Resource CD-ROM (choose View Samples from the 
Startup Wizard) provide ample evidence. We’ve sprinkled the artists’ 
insights as tips throughout the Companion, and below you’ll find 
several more relating especially to animation. As a bonus offering, see 
the descriptions in the special Production Notes Gallery (click 
Production Notes from online help). 

♦  Scene planes can serve as walls, floors, or ceilings, or you can 
switch them off for unlimited vistas. Consider yet another option... 
you can achieve some intriguing animation effects by placing 
objects, lights, and viewpoint inside a large object! For example,  
you might use the 3D Workshop to lathe an L-shaped object, 
creating a hollow, open-bottomed cylinder. In ImpactPlus, use the 
View Distance tool to position the viewpoint inside the cylinder... 
create some objects inside... and you now have a new virtual space 
whose dimensions are under your control! If you apply a texture to 
the cylinder, it wraps around the interior walls and becomes a fake 
“background” that you can move, rotate, and scale. Try this as 
part of an animation sequence to simulate camera movement! 

♦  Consider using a light source that casts shadows and also jitters 
slightly during an animation, to create the impression of 
flickering. You can also use shortening or lengthening shadows 
(made by light sources moving up or down in a scene) to mimic a 
sunrise or sunset in a scene that perhaps only uses the bottom 
plane. 

♦  Distending objects with the Deform tool’s simple “push-pull” 
technique (see the next chapter) is a great way of forming shapes 
that you cannot otherwise create with ImpactPlus. And as we’ve 
noted, Deformation is also a property that can be animated using 
key frames. Not only can you morph from one shape to another—
you can make a tail wag, a tree bend in the wind, and much more. 
Try using a Reflective Environment texture for the eye-catching 
effect of a reflection that shifts as an object deforms. 

♦  Texture animation affords lots of possibilities. Besides shifting a 
standard texture on an object during animation (by moving, 
rotating, or scaling), you can apply textures that bring their own 
animation with them! Simply import an animated GIF or AVI 
movie as a texture. The standard technique lets you mimic camera 
motion, or simulate falling rain or snow or a flickering flame. 
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With the second method you can include a TV in your scene that 
actually plays a movie during an animation. 

♦  Manipulating transparency in adjacent frames of an animation 
lets you do cuts, fades and dissolves where one or more objects 
suddenly (or gradually) appear or disappear. This is an essential 
trick in creating movie titles and works well in complex scenes, 
too. First of all, create the objects you’ll need, and keep them all 
visible until you’ve decided exactly when (like actors onstage) 
they’ll each need to be onscreen. Then set Transparency key 
frames for each object, and finally use the Transparency slider to 
set the values. Using adjacent key frames, you can have an object 
switch completely on or off from one frame to another.  

♦  Finally, here’s a mundane reminder that will serve you well in 
many situations: Don’t overlook the Status panel of the Studio’s 
Attributes tab. Not only will this let you move and rotate objects 
and set the viewpoint with great precision, it will help you 
overcome optical illusions based on depth perception. In 
ImpactPlus as in the real world, sometimes it’s hard to tell if an 
object is small, or merely far away! At least in ImpactPlus, you 
can resolve confusion by checking the Position and Size values on 
the Status panel.  
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Editing 3D Text 
Text takes on a whole new significance when it leaps out at you in 3D. 
Flat typography turns into sculpture with the addition of a depth plane. 
Even single characters begin to resemble intricate carvings or 
profound monoliths. Add to that the possibilities of animating color, 
shape, and positional changes, and there are virtually no limits to 
where you can take text in ImpactPlus! 

 

 If you’ve followed Chapter 3’s guided tour, you already know 
how to enter text using the Insert Text tool, found both on the main 
window’s Tools toolbar and in the 3D Workshop (see Chapter 6). You 
know that selecting the tool pops up a text edit window where you can 
enter your text, and that you can double-click a text object in the scene 
to edit it some more. And you can always enter text by pasting it via 
the Windows Clipboard. This section will cover a few additional 
things you should know about text objects, particularly if you intend to 
produce or edit animated text using the techniques discussed in 
Chapter 4. 

The key point is that text objects are groups, which means you can edit 
either the whole object (one or more words) or any component 
character. For clarity, we’ll refer to these as strings and 
characters.The distinction applies even if the string consists of only 
one character—the Navigator always lists the letter(s) separately. The 
first click on a text object selects the string, while subsequent clicks 
select individual characters for editing. To reselect the string, first 
click elsewhere to deselect all characters; then click the text object to 
start the cycle again. 

♦  For either string or character objects, you can alter properties like 
position, size, stretch, and rotation using the standard tools on the 
Tools toolbar.  

♦  To change the object’s edge contours, apply a bevel preset (see the 
next section) from the Studio’s Bevels tab, or customize the edge 
using the Bevels panel of the Attributes tab. 

♦  Chapter 3 introduced the concept of a material definition 
(consisting of an object’s base color, texture, transparency, and 
shine attributes). For either string or character objects, you can use 

Wingdings characters 
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the Studio’s Materials tab to apply these material attributes 
independently to the front, back, and/or sides of the object. We’ll 
return to materials in a moment. 

Character formatting repeats if you add new characters to the string. 
That is, the first new character takes the formatting of the first old 
character, the second follows the second, and so on. As an experiment, 
we started with the three-character string “ABC” (1), and adjusted the 
position and rotation of each character separately as in (2). Then we 
used the Text window to add the letters “DEF” with the result shown 
in (3). You can see how the formatting repeats in the added letters. 

 

This rule of “repetitive formatting” applies to any individual character 
attributes you alter, including color, bevel, etc. 

As for other objects, you can save a text object’s material attributes to 
the Studio’s Materials tab as a preset for future use. With the object 
selected, open any gallery (or create a new one), then right-click any 
thumbnail and choose Add From Selection. Repetitive formatting 
pertains here, too. When you save a string object’s material, you’re 
actually saving the sequence of material attributes used in that 
particular sequence of characters. The definition thus incorporates a 
repeating pattern based on the number of characters in the word. Note 
that position information does not get saved as part of a material 
definition. 

In the example below, we started with a two-letter text object and set 
the first letter light gray, the second one dark gray. Then we selected 
the whole string and saved its material. The same material was then 
applied to the longer text object: you can see how the light/dark 
pattern has repeated itself.  
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Bevel 
You may have noticed that when you create a new 
QuickShape—say, a rectangular solid—its edges 
seem a bit rounded rather than completely sharp. 
And if you apply a color to only the front or back 
face of the object (using the right-click Apply to 
Front or Apply to Back commands), the color 
seems to extend partway along the sides.  

As the examples suggest, the front and back edges of QuickShapes are 
more complex than you might think. The same goes for other objects 
you can create in ImpactPlus—text and 3DW (3D Workshop) 
objects—as well as imported metafiles. All these can have what’s 
known as a bevel region, a kind of extra bulge that adds definition to 
the edge. More technically, a bevel is a contour or profile defined by 
two curves, either of which can be round (convex), flat, or chiseled 
(concave).  

 
 Round Flat Chiseled 

The Studio’s Bevels tab includes a slew of preset bevels that you can 
apply to any suitable object. And the Attributes tab includes a 
Bevel/Lathe panel where you can fine-tune the bevel effect by 
adjusting its separate parameters, as shown in this diagram: 

 

Extrusion 

Depth 

Border 
Weight 
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Extrusion is the object’s thickness (Z-axis measurement) without its 
bevel; and Depth is the extent of the bevel “bulge.” Adjustments with 
the Stretch tool, by the way, affect both properties. The two other 
settings, Weight and Border, refer to the width of the lower and 
upper curves, respectively. You can also specify a bevel of None, 
which removes the bulge and leaves a perfectly sharp edge if that’s 
what you want. 

Bevel properties go hand in hand with independent front, back, and 
side material definitions. In other words, objects that lack bevel 
properties—such as imported DirectX models and presets from the 
Basic Shapes group—don’t lend themselves to front/back/side 
customization as do native ImpactPlus objects. We’ll have more to say 
about materials over the next couple of sections. 

Light and Color Components 
Chapter 3 explained how to set the Base color component of objects, 
planes, and lights using the Color/Transparency panel of the Studio’s 
Attributes tab. Before considering the other components, we’ll need to 
step back and consider what light and color actually mean—and how 
they’re handled in ImpactPlus. 

When we discuss color in layman’s terms, we may speak of a “green” 
street light, a “red” ball, or the sun reflecting “bright orange” off the 
water. In reality, of course, something much more complicated is 
going on: a mixture of different wavelengths of light, differently 
absorbed or reflected by various surfaces, is being detected by our eyes 
and brain. The mathematical ImpactPlus world steers a middle course 
between the simple and complex. 

In ImpactPlus, the various types of lights all produce light in the 
scene. Objects and planes, in general, only reflect light from their 
surfaces. We can set the properties of lights and surfaces 
independently, and the interaction determines the surface color. For 
example, in Chapter 3 we saw how to change the Base color of a light 
and/or a surface for different resulting colors. 

As you’ve probably guessed, there’s more than just one such 
interaction—actually up to four—because ImpactPlus treats “light” 
itself as consisting of four color components called Base, Highlight, 
Ambient, and Glow. Each component describes a particular “quality” 
of light, as described below. We can adjust the color of each 
component produced by a light, and also how a particular object or 
shaded plane reflects each component. It’s the sum of these 
interactions that determines the color of the surface. 
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 should already be familiar: it refers to the main value of the 
color produced by a light source, or reflected by a surface. In layman’s 
terms, it’s what we mean when we speak of as a green street light or a 
red ball.  

 relates to what we perceive as shininess: light glinting off 
an object or plane. For fine control over these “specular” reflections, 
you can set the Highlight value (for a light or surface) separately from 
the Base component. For objects and planes, you can also adjust the 
Shine setting which works like a coefficient or multiplier to determine 
the intensity of the reflection. Typically, an object or plane’s Highlight 
color is set to some grayscale value, so its highlights will be the same 
color as the light source(s) hitting it. 

 only pertains to the single light source called Ambient, 
which can be switched on to let you vary the amount of “background” 
light that is “everywhere” in the scene. This Ambient Light has only 
an Ambient component. For an object or plane, the setting determines 
how much of the scene’s Ambient light gets reflected if the source is 
switched on. 

 applies only to objects and planes, not to lights. Normally its 
value is black (zero), but you can increase this for any object you want 
to represent a light source in the scene, for example a car headlight. 
(This is the exception to the rule that objects can only reflect light.) 
Planes are given a slightly gray Glow setting by default, just so they 
won’t disappear if all the lights go out. 

For light sources, the intensity or brightness of the light corresponds to 
the lightness setting (i.e. grayscale value) of its color components. In 
other words, you can dim a white light either by reducing its Intensity 
setting (on the Lights toolbar) or by making its Base component color 
grayer (on the Color/Transparency panel). And you can switch a 
component off by setting it to black. 

We tried the preceding adjustments in Chapter 3, but here’s a bit of 
further information. When you use the Intensity slider, the result 
affects the light’s Base and Highlight component equally. When you 
use the Color/Transparency panel, you can set colors separately for 
each available component.  
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Experiment with the four color components, as well as the Shine and 
Transparency sliders. The more objects in your scene, the more 
possibilities for unique light/object interactions! Fine-tuning the 
settings can make objects vary from metallic to waxy, from shiny to 
matte. Check out the creative usage of color settings in the ImpactPlus 
Samples—for example, in “Still Life,” the dark Glow which lends an 
organic look to the fruit on display. 

Texture Components 
In Chapter 3, we introduced the concept of material properties that 
contribute to the surface appearance of each object, and experimented 
with applying preset materials from the Studio’s Materials tab. 
Texture is a key ingredient of a material definition—and like color, 
turns out to be a bit more complex than it might appear at first glance.  

The Texture panel of the Studio’s Attributes tab lets you design a 
custom texture using your choice of texture components. You can 
apply Base and/or Environment texture components, with two 
alternative choices (Surface or Reflective) in the Environment 
category.  

♦  Base refers to a basic texture component. A Surface Environment 
component is essentially a secondary Base texture. 

♦  A Reflective Environment component looks like an external scene 
mirrored by the object’s surface. The reflective texture appears to 
be separate from the object, which may not be immediately 
obvious until you animate the object—but then, it can be truly 
impressive! 

♦  If your computer’s graphics card supports hardware bump 
mapping, you also have the option of modifying the Environment 
texture using a Bump component. A Bump texture adds the 
impression of surface peaks and valleys. Grayscale variations in 
the applied bitmap translate into elevation data (black = high, 
white = low). 

 
 Base Surface Reflective 
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Applying a texture is simply a matter of making selections in the 
Texture panel. For example, check Base to apply a basic texture 
component. Click the thumbnail, then use the dialog to choose a 
specific image file. If you want to specify a single color that will 
become fully transparent in the scene, check Transparent in the 
dialog, then click the color button and use the dropper cursor to select 
a single color in the preview image. 

Any texture components you apply become part of the object’s material 
definition (along with color, transparency, and shine), and will be 
saved for each object when the scene itself is saved. An object without 
texture shows only continuous color. 

Once you’ve applied a texture, you can 
then use the Texture toolbar to fine-
tune the placement of its components 
independently. Click the Move 
Texture, Scale Texture, or Rotate Texture button and drag on the 
object to adjust. Three other toolbar buttons let you select any or all of 
the three possible texture components, so you can further refine your 
changes. 

The Materials tab lets you apply a preset texture 
independently to the front, back, or sides of text, 
QuickShapes, 3DW objects, or imported metafiles. 
But if you edit or define the texture of one of these 
objects via the Attributes tab, the result affects all 
faces of the object at the same time. Fortunately, 
you can use simple workarounds to define different 
custom textures for different faces:  

♦  A standard method is to use a sample object 
and use the Attributes tab to build up a texture 
definition on that object, and then save it as a 
custom preset in the Materials tab. This gives 
you a texture you can apply to any face of an 
object, as needed.  

♦  In another situation, you might apply a texture 
first to the object’s front, and scale it down to half size. If you then 
applied a texture to the sides and scaled down by half again, the 
front texture would be one-quarter of its original size and the side 
texture one-half. 
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Separate front, back, and side attributes can add complexity (and 
creative possibilities) to the material definition! It’s possible to have a 
master transparency setting for the whole object, and then separate 
Base, Glow, and Highlight (with its Shine setting) components for 
each of the front/back/side faces—not to mention up to three texture 
components for each face, and (for text objects) formatting variations 
over a range of characters! 

With textures, complexity isn’t the only avenue to creativity—a little 
bit of imagination can go a long way. For example, by carefully 
positioning a texture with transparency (try creating your own simple 
two-color bitmaps in a photo editor!) you can create “holes” in objects, 
define unique shapes, or simulate twinkling highlights. Add 
animation, and you can produce kinetic effects like rainfall. You can 
even import a GIF, MPG, or AVI movie, which then becomes an 
animated texture—for example, playing on the “screen” of a “TV set”!  

The Reflective Environment component works especially well with an 
extremely wide-angle photo as a source. Try to find one that fits in 
with the contents of your scene: for example, a landscape, skyline, or 
room interior. Create your own source images with a digital camera, a 
paint program, or even with ImpactPlus! For example, in the “City 
View” Sample, the attractive reflection in the glass dome near the 
center was created expressly for this scene: a simple picture of some 
tower blocks with illuminated windows, using basic shapes and 
contrasting colors. Then the image was brought in as a Reflective 
Environment texture... not much effort for a striking result. 

Deformation and Morphing 
The Deform tool, located on the Tools toolbar, lets you achieve 
incredible, elastic warping effects by pulling and pushing the nodes 
(vertices) where the faces defining a 3D object come together. For 
example, you can extend selected points of a star, turn a sphere into an 
egg, or make text appear to melt. To create dynamic, animated 
morphing effects, try varying the Deformation property between 
frames! 
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The tool works like a magnetic brush, with 
variable settings that determine its effect. 
As soon as you choose the tool, a special 
palette appears. Select a preset brush and 
then customize it as needed using the 
Diameter and/or Focus adjustments. The 
wider the Diameter, the larger the tool’s 
coverage area. Higher Focus means a more sharply defined boundary 
between affected and unaffected nodes; less Focus means more gradual 
falloff toward the brush edge.  

Simply drag on the object’s edges to move its nodes and deform its 
shape. 

For an actual view of object nodes, you may find it useful to zoom in 
and switch to Wireframe view using the Draw Style toolbar, or open a 
secondary window. The more nodes in the original object, the more 
effective the Deform tool will be. For example, a sphere will deform 
much more dramatically than a cube. When operating on group objects 
(including text objects and 3DW objects), the Deform tool affects 
component objects, not the whole group. 

In general, apply deformation only after you’ve finished editing objects 
in other ways. Operations like changing bevel, revising text, or re-
editing an object in the 3D Workshop will remove any deformation 
you’ve previously applied. 

Anaglyph (Stereo) Images 
Although ImpactPlus stores information about all three dimensions of 
a scene, a standard “3D” image (as viewed on screen or printout) is of 
course only two-dimensional—no less convincing when viewed with 
one eye closed. But try pouring an actual glass of milk with that same 
eye closed, and you may need to clean up afterwards! Depth perception 
in the real world is highly dependent on binocular (two-eyed) vision. 
Stereo photography, popular since the 19th century, takes advantage of 
the brain’s rather amazing ability to extract depth information from 
two different pictures (originally taken several inches apart), when 
they are presented to each eye separately. Over the years, a wide 
variety of systems have been developed for storing and displaying 
stereo images as both still and motion pictures. The popular anaglyph 
method is one of the simplest yet most effective of these techniques. 
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You’ll be glad to know that creating anaglyph stereo images with 
ImpactPlus requires no extra knowledge at all! Achieving great (as 
opposed to merely good) results takes a bit more preparation—but that 
can wait until later in the section! You can experiment with this cool 
feature using any standard 3D scene. Ready? Here goes: 

� Prepare a 3D scene, using regular ImpactPlus tools and 
techniques.  

�  To preview the scene as an anaglyph image at any time, 
simply click the Fullscreen Preview button, then right-click and 
choose Anaglyph View. Put on your special red-cyan 3D glasses 
for an instant stereo image! 

� To change the preview size, right-click and select Fit to Screen, 
Half Size, Full Size, or Double Size. To return to the scene 
window, press Esc or right-click and choose Close. 

� To print the scene as an anaglyph image, choose Print from the 
File menu (or click the Print button) and select the Anaglyph 
option. 

� To export as an anaglyph, choose Export from the File menu, 
then select Scene, Animation, or Animation Stills from the 
submenu, and finally the Anaglyph submenu option. 

Now that you’ve seen the “good” results, how about achieving 
greatnesss? First, a bit of background theory is in order... 

The anaglyph method relies on the fact that a color filter lets through 
only certain wavelengths, causing objects of that color to appear 
relatively brighter. Through a red lens, for example, a red line looks 
just as bright as its white background—and so the line “disappears,” 
while anything in a complementary color turns quite dark. Anaglyphs 
use two different colors to store two images on a single page, and 
special glasses with two color filters let each eye see a different image: 

 
 Left eye view (cyan) Right eye view (red) Anaglyph 
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ImpactPlus can render any 3D scene as an anaglyph image, and then 
export or print the result. Internally, it generates two separate pictures 
of the scene: one as if from the left eye’s viewpoint, the other from the 
right, with the two viewpoints separated by an adjustable offset called 
the base. Then it creates an anaglyph by overlapping the two views, 
using cyan hues for the left-eye view and red for the right. When you 
gaze at this double image through your red-cyan glasses, each eye sees 
a different image and your brain does the rest—using the difference 
information, known as parallax, to construct an illusion of depth. (Try 
viewing an anaglyph through one eye at a time.) You can export 
animations, too... ImpactPlus simply repeats the same process for each 
frame in the sequence! 

As you’ve seen, it’s easy to create anaglyphs, but some are more 
successful than others, and you can take a number of steps to improve 
your results. For a start, familiarize yourself with the Anaglyph 
Calibration Wizard, which helps you to fine-tune each image for 
maximum impact, whether onscreen or for the printed page. We 
suggest you run the Wizard (File/Anaglyph Calibration...) each time 
you create an anaglyph using a new scene size or color scheme. 

 

The Wizard consists of two steps, each based on picking the best result 
from an array of images that use different settings. At each step, you 
can either preview the array onscreen (click Fullscreen) or print it out 
(click Print). Use the method that corresponds to your intended output, 
as screen and printed color reproduction can differ significantly. If 
none of the choices seems acceptable, you can return to the Wizard 
screen and extend the range of values at either the low or high end 
(simply enter a new From or To value as needed), and then repeat the 
preview phase. When you’ve decided on the best preview image, click 
the corresponding numbered thumbnail on the Wizard screen. 
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In step one, as shown above, you determine the optimal base setting 
from a preview array where each image uses a different left-right 
viewpoint offset. Here, you’re looking for the image with the most 
dramatic 3D effect but without excessive “ghosting.” Keep in mind 
that if you expect to scale the image down at some point (i.e. the 
preview is significantly larger than the final size will be), you can 
choose an exaggerated base value now, as the offset will of course 
shrink when the image is downsized. For best results, do your scaling-
down in ImpactPlus and calibrate using an image of final size. 

In step two, all the samples use the same offset (the base value you’ve 
just selected), but they differ in the saturation level applied to the 
image. Saturation produces ghosting in contrasty or colorful scenes, so 
the ideal setting may vary considerably from one scene to another. 

You’ll see the result of updated settings the next time you choose 
Fullscreen Preview. ImpactPlus will store the settings and apply them 
to future previewed, printed, or exported images until you run through 
the Wizard sequence again.  

Anaglyph tips 
While there is no magic formula for producing perfect anaglyphs, if 
you manage colors correctly in designing the anaglyph scene, you’ll be 
able to keep the saturation level high and still achieve a strong stereo 
effect. One relatively foolproof method is to use only grayscale values 
as in a “black and white” photo. In this case, the two anaglyph images 
will be shades of pure red and cyan, with no spurious hues in between. 
Through the 3D glasses, each eye will receive only a single image and 
the other one will be filtered out. Even in this case, you should avoid 
using very dark or light regions, as these may exceed the filtering 
range of the glasses and result in ghosting. 

Chances are you’ll want to add color to your scenes, however, and so 
the situation becomes more complex. For example, since all left-eye 
information comes from the color red, a bright red sphere will present 
no right-eye information and hence no stereo effect. Similarly, blue 
objects will lack left-eye information. The worst case would be a scene 
drenched in red or blue colors... as you can imagine, these would 
completely interfere with the red-cyan anaglyph separation. To avoid 
such depth dropouts, avoid using saturated reds, blues, and greens. 
Summing up, then, middle shades—especially of brown, yellow, and 
gray—will produce more satisfactory anaglyphs.  
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Welcome to the Workshop 
If you’ve explored the Studio’s Models tab, you’ve seen the tremendous 
variety of objects of all descriptions stored there. Just about all were 
created in ImpactPlus using the 3D Workshop! 

 

The Workshop provides an easy-to-use environment where you can 
create your own simple or complex 3D models from scratch. You can 
save the objects as separate 3DW files (using the .3DW extension), 
quickly transfer them into any scene, and store them conveniently in 
the Studio to reuse later. 

And you don’t have to be a master craftsman to use the Workshop—a 
few basic concepts will carry you a long way. In this chapter we’ll take 
a leisurely stroll through the facility and explain the various tools as we 
proceed. Come on in—no safety goggles required! 

Guided Tour: The 3D Workshop 
The 3D Workshop is a special-purpose window within ImpactPlus that, 
when launched, takes over from the main scene window. There are two 
basic ways to launch the Workshop. If you’ve already brought a 
Workshop-created object from the Models tab into the scene window, 
you can simply double-click the object to edit it. Or, to start from 
scratch, take this direct approach: 

�  Click the 3D Workshop button on the Tools toolbar.  

The window changes into the 3D Workshop, with its own toolbars, 
drawing region, Preview window, and controls. 

 

Preview 
Window 

Toolbars 

Drawing 
Region 

Controls 
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In a nutshell, the creation process works like this. First, you outline a 
two-dimensional (2D) figure, using any of the available drawing tools. 
Once you’ve closed the outline on itself, the Workshop projects the 
closed shape into 3D space and displays an animated preview. You can 
edit the original figure, change its colors, and adjust various attributes 
until you’re happy with the 3D object, at which point you transfer it 
into the ImpactPlus scene window and exit the Workshop. 

Let’s take things one step at a time, and have some fun. 

From 2D to 3D 

�  On the left toolbar, click the Insert QuickShape button. 
(QuickShapes are also supported in the main window, and were 
covered in Chapter 3.) Choose the “Donut” shape (top row, right) 
and drag out a shape in the drawing region. Hold the Shift key 
down when dragging to obtain a circular shape. 

 

The QuickShape is already a closed 2D figure, of course, so as soon as 
it appears, its 3D projection starts animating at the right. Let’s make a 
few quick observations. 

� Check the X box in the Rotation panel, just above the Preview 
window. With both X and Y checked, the shape rotates around 
two axes rather than just one. Try checking the Z box also, and 
then uncheck one of them. Rather compelling, isn’t it? 

� Now click the Stop button, and then the Reset button. Right away 
the shape snaps back to its original orientation, matching the 2D 
figure. Click Play again to resume the preview motion. 

Now it’s the QuickShape’s turn for some attention. 

� Click the top button on the left toolbar to select the Edit Tool, then 
click the QuickShape to select it. Drag any of its adjustment 
handles to see both the 2D and 3D shapes respond. Can you turn 
the donut into a tiny sliver? 

A key advantage of creating QuickShapes in the Workshop, rather 
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than in the main window, is that here they remain editable 
indefinitely—you can switch to other tools or change settings, and still 
return to the shape to make more adjustments. 

With the QuickShape still selected, you may be 
wondering about the three little boxes at its lower right. 
These color handles afford a direct way of 
applying color to (respectively) the front, back, 
and sides of a Workshop model.  

� In the Color gallery below below the preview window, click the 
red swatch and drag it over to the object’s first (i.e. left) color 
handle. Now repeat this with the adjacent green swatch, but this 
time drop the color on the second color handle. The rotating 
preview will reveal that front and back are now differently 
colored. 

� Here’s another way to apply color. Right-click the blue swatch 
(next in line after the green one) and choose Apply to Sides. Note 
that the other options are on the menu, too, including Apply to 
All, which could save you some steps if you want the whole 
surface the same color. 

While the object is still multi-colored (red, green, and blue), let’s test-
drive another set of Workshop controls and get a simple demonstration 
of RGB color mixing. 

� In Lighting panel at the right, drag the R (Red) slider all the way 
to the left, to turn off the red component. The front face of the 
object, which was red a moment ago, is now black—because 
there’s no red light to be reflected.  

� Now drag the G (Green) slider to the left. With both red and 
green components gone, both front and back of the object appear 
black. 

� Right-click the white color swatch and choose Apply to All. Now 
that the object’s base color is back to a pure white, it appears solid 
blue under the single remaining (blue) light source. 

� Slowly fade up the R and G sliders and watch the object reflect 
various mixtures of the three primaries. With all three sliders back 
up to maximum, the shape appears white once again... a nice way 
of showing that red, green, and blue add up to white light. 

The main window’s Lighting controls are independent of those in the 
Workshop. As we’ve just seen, in the Workshop you can use the color 
swatches, lighting controls, or both, to achieve a particular coloration. 

Front  Back  Sides 
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When you transfer the object to the scene, however, any color applied 
in the Workshop merges into the object’s Base color component. (The 
other components are assigned automatically: Ambient takes on the 
Base value, Highlight is set to light gray and Glow to black or zero.) 
The scene’s own lighting scheme will be superimposed on the object 
components to create a final effect.  

Any time you want to transfer a Workshop object to the scene, simply 
click the OK button at the lower right. (You can resume editing the 
object later by double-clicking it in the scene to launch the Workshop.) 
Clicking Cancel returns to the main window without transferring the 
object; you’ll lose any unsaved changes in the Workshop. To save the 
Workshop contents at any point, click the Save or Save As button. 
You can load previously saved objects using the Open button. 

Each Workshop-created object you transfer into the scene appears in 
the Navigator as a “Group 3DW Object”—even if it has only one 
component object. In this respect, 3DW objects behave like text 
objects. 

Turn, turn, turn 
Impressed with the 3D Workshop so far? Hold on, here comes the best 
part! 

� By now, your “donut” QuickShape may have morphed 
considerably from its original form, so it’s probably best to start 
over with a new shape. You can either delete the old one (simply 
select it and press Delete), or click the New button to clear the 
drawing region. Then drag out a new donut as before. 

� Select the new QuickShape with the Edit tool and adjust its right 
handle to rotate the shape so it’s oriented like the letter “C.” The 
shape should be roughly centered in the drawing region. Finally, 
in the Rotation panel, check only the Y box, leaving X and Z 
unchecked. 

� Now select Lathed in the Creation panel at the right.  

In the Preview window, the 3D projection turns into a flat shape that 
looks like a pulley of some kind. What’s going on? A single trial 
adjustment will reveal all. 
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� In the Creation panel, drag the Degrees 
slider to the left about halfway. Now the 
Preview window shows only half of the 
pulley—and you can clearly see it has a 
C-shaped cross-section that matches the 
2D figure. 

Just as a real-world lathe turns a workpiece around a long axis so it 
can be carved or shaped, Lathed mode takes the 2D drawn shape and 
revolves it around an axis line to produce a 3D projection. The 
Degrees slider lets you achieve a partial turn, anywhere from a full 
360° down to a mere sliver. Previously, we were working in Extruded 
mode, where the flat 2D figure was simply extended a bit along the Z 
axis to give it some depth. 

� Drag the 2D shape toward the dashed red axis line at the left side 
of the drawing region. Notice that the hole in the middle of the 
“pulley” gets smaller as the space between the shape and the axis 
decreases. 

� Check the X box to add X-axis rotation. Wait until the 3D shape 
comes round to a position where you’ve got a clear view of its 
various profiles, and then click Stop to freeze it. (You may have 
to click Play and Stop a few times to achieve the best angle.) 

� Now for some experimentation. Try adjusting one or more of the 
QuickShape’s handles in small increments, and notice how the 3D 
shape changes. (If you wish, restore the Degrees slider to its full-
turn position.) See what happens if you drag the figure beyond the 
axis line: anything to the left of the line will be ignored. 

� Drag the Smoothness slider all the way to the left. The result: a 
three-sided shape, but still with the 2D figure as its cross-section. 
Jog the slider little by little to the right, and you can add one side 
at a time. Interesting possibilities here! 

Note that the Bevel/Lathe panel of the Studio’s Attributes tab includes 
its own Degrees and Smoothness sliders, so you can continue to fine-
tune your “turned” 3DW objects after you’ve transferred them back 
into the main window. 

� Just for fun, switch back to Extruded mode, which now looks tame 
by comparison (but no less useful).  
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Who would have guessed that a humble donut could shape-shift into 
such varied forms? But there’s more beyond QuickShapes... you won’t 
even approach the Workshop’s limits until you’ve tried its drawing 
tools. For an introduction, step right along to the next section. 

 

Drawing shapes 

�  Click the New button to clear the drawing region, and select 
Extruded mode for a simpler 3D preview. 

�  Click the Freehand Tool button. In the drawing region, click 
for a starting node, then drag with the tool to draw something 
approximating a circle. End the line where you began it—on the 
starting node—to close the shape. The extruded projection 
appears instantly in the preview window. 

� Press Ctrl+Z to undo the drawing, and try again. This time, trace 
something with a wavy outline, such as a head in profile or an 
imaginary island. 

� Clear the screen again and draw an 
incomplete curve (not a closed figure), then 
click (without dragging) somewhere else. 
Click a third time and drag out a short 
segment, then end by clicking the starting 
node. The numbers in the illustration show 
one possible sequence. 

With the Freehand tool, clicking to place a new node automatically 
connects it to the previous node. Dragging from an existing node 
(including one you’ve just placed) attaches a curve in any shape you 
draw.  

�  Select the Edit tool and notice the distribution of nodes 
around the outline. (It doesn’t matter if your figure differs 
somewhat from the illustration above.)  
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� Now for a small challenge. Using only the Edit tool, see if you can 

transform your shape into something like 
this...  
 
Need a hint? Dragging a line segment is 
the easiest way to change the figure’s 
shape. You can drag nodes, too, to change 
their position. Watch the tool cursor to see 
whether you’re over a node or a segment. 

The last key point about freehand drawing and editing concerns nodes, 
which are slightly more complicated than they first appear. 

� Drag each node of your figure in turn, moving it slightly away 
from the center. Don’t worry about the resulting shape; just 
separate the nodes from each other. 

You’ll notice that certain nodes—at the junctions where you initially 
clicked a separate point and ImpactPlus drew a connecting line—are 
actually pairs of nodes that you can drag apart. These extra nodes in a 
drawn figure are normal, resulting from the Workshop’s attempt to 
match the shape you drew. 

� Look for any node that joins two curved-line 
segments (the tool cursor on each side 
should show a wavy line). Click the node to 
select it.  

You’ll see two green lines heading off in separate directions from the 
node. These are called attractor handles and 
they let you fine-tune the shape of a segment 
where it adjoins a node. You can precisely 
adjust the slope or angle at which a segment 
leaves a node, and also the segment’s depth, i.e. 
how much it bulges in or out.  

� Try dragging one handle, then the other, to see how the segments 
respond. Now try dragging some nodes elsewhere along the 
figure. You’ll notice that nodes joining a curve to a straight-line 
segment have only one attractor handle, which makes sense 
because the straight line has a fixed slope and depth. 

In any figure you draw from scratch, the nodes initially will be of the 
sharp variety—that is, the segments on either side of the node are 
completely independent of one another. For more rounded contours, 
you can use the buttons on the Node Edit toolbar at the lower left to 
convert a node to either smooth or symmetric. Smooth nodes force the 
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adjoining segments to assume the same slope, although they can have 
different depths. Symmetric nodes produce perfect rounding, where 
the segments have the same slope and depth.  

                       

� To convert a node, select it and then click a node type button. 
Take a moment to try converting one or more nodes to smooth or 
symmetric, then drag the segments on either side to see how the 
figure responds. 

Note that the Node Edit toolbar also includes a Straighten Line 
button, which straightens out the segment on the trailing side of a 
node, and a Delete Node button, which helps to simplify a shape. 

�  Click the Line Tool button and create a new shape by clicking 
to place each corner point of the figure. The connecting lines are 
drawn automatically, and this time you only get single nodes at 
each junction. 

You’ve probably noticed—but it’s worth emphasizing—that the 
drawing region can handle any number of separate objects, which 
appear in the Preview window (and when tranferred to the scene) as a 
single, composite object. It’s a valuable technique for adding extra 
protrusions and contours, or if you’re creating complex models like 
those in the ImpactPlus Studio, for example. 

�  To complete your survey of the drawing tools, click the 
Curve Tool button. This tool works like the Line tool—you click 
to place a series of points, which are automatically connected—
but in this case the connecting lines are curved. You can drag 
after each click to adjust the new node’s attractor handles and 
roughly shape the preceding segment. Now that you know about 
nodes and segments, you should find the tool straightforward to 
use.  
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Text and more 
Before winding up this tour, let’s briefly survey some of the other tools 
and functions that add convenience and power to the 3D Workshop.  

 The Workshop has a Text tool that works very much like the 
standard Text tool in the main window. In the Workshop, only 
individual characters—not whole strings as in the main window—are 
selectable. Generally speaking, type single characters into the text 
creation window. The tool is most useful for creating single “dingbat” 
characters, or supplying letter shapes as a starting point for creative 
distortions. 

 

 Another creation option is the Insert Metafile button, which lets 
you import a .WMF or .EMF file created in an outside program. 
Imported metafiles are converted to multiple complex polygons, 
typically with more nodes than you’ll want to edit—but they are easily 
scaled, and this is still a convenient method of bringing external 
content into an ImpactPlus scene.  

  Click the Zoom In and Zoom Out buttons to adjust the 
working view. 

 The Zoom to Fit button resets the view to its initial state. 

 To turn on a point grid as a drawing aid, click the Snapping 
button. With the grid turned on, nodes you draw “snap” to the nearest 
grid point—especially useful when drawing straight-edged figures. 

 Click the Show/Hide Nodes button if necessary to reveal the 
nodes for editing, or conceal them for a clearer view of the figure. 

 Use the Preferences button on the top toolbar to adjust the grid 
color and spacing, or to set the background color of the drawing 
region. 
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Aside from printing a scene out directly, there are two basic ways of 
incorporating an ImpactPlus image in a video, publication, or other 
graphic context: exporting and OLE. 

Exporting 
Exporting means converting an ImpactPlus scene to an external file 
format, as opposed to saving it in the native .IPP format. You can also 
export one or more selected objects as a DirectX (.X) file. Once you’ve 
exported your ImpactPlus creation to a suitable format, you can bring 
it into your favorite video editor, Web page editor, DTP, word-
processor or any other application you choose. 

Besides exporting the scene exactly as it appears on the screen, you 
can output in two other modes: 

♦  As an anaglyph (stereo 3D) version of the scene, designed to be 
viewed with red/cyan glasses. For details on making and 
previewing anaglyph images, see Chapter 5. 

♦  As a depth map—a grayscale representation that uses lightness 
values to encode depth information in the scene, with 256 possible 
levels for each underlying image pixel. Lighter areas represent 
peaks and darker areas represent valleys. You can use depth maps 
in conjunction with programs like Serif PhotoPlus which can 
import them to add 3D realism to standard “flat” images. 

Whichever of these options you choose, the entire main window gets 
converted to an anti-aliased bitmap graphic (or a series of them, in the 
case of animations). You can fine-tune single graphics in a paint 
editing program like Serif PhotoPlus, so for example you don’t have to 
worry if there’s extra background showing around the scene objects—
final cropping can come later. With animations or video clips, you’ll 
have much less flexibility after export, so take care to follow the advice 
given in Chapter 4. In all cases, make sure you’re satisfied with the 
composition, lighting, and colors in the scene before you export—it 
can be quite difficult to change those later. 

Mechanics of exporting 
To export a static scene, choose Export from the File menu and 
Scene from the submenu. Then select Image, Anaglyph, or Depth 
Map. In the dialog, use the Save as Type pull-down menu to specify 
the export file format. Provide a file name and folder location, and 
click Save. In the Export dialog, specify scaling and set options 
available for the particular format (see below), then click OK. 
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The basic steps are similar when exporting an animation. Choose 
Export from the File menu but select Animation from the submenu. 
Choose the export type and specify the format (.GIF or .AVI) and file 
name. Again you can set options in the Export dialog.  

You can also export animations as sequences of separate still-image 
files—useful if you need to use a format other than .GIF or .AVI, and 
plan to continue editing the animation in a program that can import a 
series of stills. With this method, for example, you could use the .PNG 
format (see below) to retain variable background transparency in the 
animation. To export as a sequence of stills, choose Animation Stills... 
from the File/Export submenu. ImpactPlus automatically generates 
the numbering sequence, from 1 up to the number of frames. 

Finally, you can export an individual object as an industry-standard 
DirectX (.X) file, for use as a model in another 3D package. In 
technical terms, ImpactPlus exports DirectX mesh data (with vertex 
normals, vertex UV texture coordinates and vertex colors), materials, 
texture references, and hierarchy. First, select the object to be 
exported. (If you select multiple objects, they will be exported 
individually.) Choose DirectX Mesh from the File/Export submenu. 

Export settings 
In the Export dialog, set any options available for the particular image 
and file format. The dialog includes an Image Preview window, which 
provides an accurate rendering of how your scene will look using the 
current combination of settings. You can zoom in and out, drag the 
scene to center it in the window, and experiment with different export 
options until the results are satisfactory. 

♦  Size: Normally, the scene will be exported at its actual size, as 
specified in the File/Scene Setup dialog. To scale the exported 
image, you can change either the Width or Height value; click 
100% to restore the original size. The other value changes 
proportionally to maintain the same aspect ratio.  
Note that for anaglyph images (see Chapter 5), scaling the image 
will affect the offset of the red and cyan components—a smaller 
image obviously means less separation—and this may detract 
from the effectiveness of the stereo image. If you plan to scale the 
image when exporting, take this into account beforehand when 
you run the Anaglyph Calibration Wizard. 
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♦  Bit Depth: Bit depth relates to the number of colors in the 
exported image. For example, a bit depth of 4 bits per pixel can 
store 16 values; 8 bits per pixel, 256, and so on. 16-bit images 
have roughly “thousands” of values to describe each pixel’s color, 
and 24-bit images have “millions.” Of course, images with higher 
bit depth take up more disk space. Choose the bit depth that 
corresponds to the number of colors in the exported image. For 
256-color images, you have the option of applying either an 
Optimized or a Web-safe palette.. 

♦  Palette: A color palette is a table of color values that gets stored 
with any image having 8 bits (256 colors) or less. If you’re 
exporting at 8 bits (256 colors) or less: 
� The default Optimized setting lets the ImpactPlus export filter 
determine the best colors to apply. This generally results in 
smooth color gradations and quite acceptable appearance when 
viewed on a High Color (16-bit) or better color display. 
� Choose Web-safe to reduce the colors to only those found in the 
216-color palette used by Web browsers on limited-color systems. 
This will ensure that an image you place on a Web page won’t 
change its appearance when viewed on such systems. 

♦  Dithering: Dithering comes into play with images being reduced 
to 8 bits (256 colors) or less. It’s a method of approximating 
colors outside the actual image palette—for example, by 
alternating pixels of red and blue from within the palette to 
produce the visual impression of a purple color that’s not in the 
palette. While dithering can degrade solid-color areas, with 3D 
images it’s usually more important to preserve subtle gradations 
of color.  
� To preserve gradations of color and/or an image background, 
dithering is clearly the best choice. You can choose either Ordered 
or Error Diffusion dithering. The former produces a discernably 
patterned effect, while the latter tends to average away the 
patterns for a more natural result.  
� To minimize file size, or if you happen to have an image with 
few colors, you can opt for no dithering—and the export filter will 
pick “nearest-match” color values from the palette being applied. 
You may see some color shifting, but the solid color areas will be 
preserved. 
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♦  Transparency: If your scene uses a solid color background and 
you’re exporting to a suitable format like .GIF or .PNG, selecting 
the Use Transparency option will turn the background 
transparent. GIF files support single-level (on/off) transparency—
one reason they’re commonly used over backgrounds on Web 
pages. The .PNG format supports multiple levels of transparency 
for “alpha blending” effects (see below). 

Note that the Transparency export setting is unrelated to the 
Transparency slider or the option of applying bitmap textures that 
use a single transparent color. Those controls affect whether you 
can see through objects within the scene itself, whereas the export 
setting affects only the scene background in the exported image. 

♦  Anti-Aliasing: ImpactPlus routinely applies anti-aliasing to 
exported images, and it’s recommended. To ensure blending at 
the edges when exporting as a GIF, match your scene’s 
background color to the color of the Web page background where 
you expect to be using the GIF. For a sharper-edged (but less 
pretty) graphic that can be placed over any background—or if it’s 
a sharp-edged effect you want—you can turn anti-aliasing off.  

♦  Compression: Compression schemes, which apply different 
algorithms to encode the image information with fewer total bits 
and bytes, are used in many formats. Depending on the format, 
ImpactPlus may include a choice of compression scheme. In 
general, use the default setting unless you know for a fact that 
some other scheme is called for.  

With the .JPG format, recommended for photographic 
backgrounds, you can set the level of quality desired using a 
slider. As you might expect, the highest-quality setting uses least 
compression, with no loss of image quality but the largest file size. 
The lowest-quality setting applies maximum compression for 
smallest size, but yields rather poor quality.  

The .PNG format 
For Web graphics, the increasingly popular .PNG (Portable Network 
Graphics, pronounced “ping”) format has a number of advantages over 
.GIF—the main ones, from an artist’s perspective, being “lossless” 24-
bit images and support for variable transparency. Whereas .GIF 
supports simple binary (“on-off”) transparency, .PNG allows up to 254 
levels of partial transparency for normal images. The image file 
includes an “alpha channel” that directs pixels in the foreground 
image to merge with those in a background image. Most commonly 
used with 24-bit images, anti-aliasing creates the illusion of smooth 



84    Working with Other Software 

curves by varying pixel colors—for rounded images that look good 
against any background, not just against a white background. It’s 
especially useful for the small graphics commonly used on Web pages, 
such as bullets and fancy text. 

Animation and video formats 
The .GIF format is what makes Web animation possible, for a couple 
of reasons. First, it’s universally supported by Web browsers. Second, 
it’s a multi-part format, capable of encoding not just one image but 
multiple images in the same file. A GIF animation player or Web 
browser can display these images in sequence, in accordance with 
certain settings (looping, frame delay, etc.) included in the file. The 
result—it moves! 

The .AVI (Audio-Video Interleaved) format is commonly used on the 
Windows platform to encode image sequences in sync with a mono or 
stereo sound track. ImpactPlus can export to the uncompressed .AVI 
format using 24-bit color, or to various compressed formats, depending 
on which codecs (compression/decompression schemes) are present on 
your machine. Our best general advice is to export your ImpactPlus 
AVIs using no compression (Use Codec unchecked); see Chapter 2’s 
“Video Setup Tips.” If you do use a codec, note that ImpactPlus 
doesn’t ship with specific codecs; however, several are shipped with 
Windows itself, and you can easily obtain others on the Web. Check 
the codec’s documentation for correct bit depth settings; 8-bit is the 
standard. Note that .AVIs don’t support certain playback properties of 
the animated .GIF format, such as “Loop” and “Ping Pong.” 

OLE (Object Linking and Embedding) 
Exporting ImpactPlus files as bitmap graphics is appropriate when 
you’re working with an application that requires images in a specific 
format (such as .JPG or .GIF for a Web page editor), or if you need to 
edit the graphic using a paint program. The drawback of exporting is 
that you lose the ability to edit the scene itself in ImpactPlus. 

Many applications—for example, Serif’s desktop publishing program 
PagePlus—allow you to insert an ImpactPlus scene as an OLE object. 
This means you can still use ImpactPlus to modify the scene later, if 
necessary. For example, you can change the text in a text object or 
alter the color scheme without having to start from scratch.  
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In some situations, exporting (as described earlier) may be your only 
choice. For example, if your graphic requires a transparent 
background, you’ll need to export to the .GIF format. Also, you may 
find that OLE can be slow and cumbersome due to the amount of 
bitmap data required for displaying and printing ImpactPlus objects at 
suitable quality.  

Following are general guidelines for working with ImpactPlus OLE 
objects in a client application. (Bear in mind that actual procedures 
may differ depending on the application and operating system 
version.) 

 Choose the application’s Insert Object... command, usually found on 
its Edit menu, and select “Serif ImpactPlus Scene” from the list of 
object types. Then, to insert a saved ImpactPlus (.IPP) file, choose the 
Create from File option and locate the file name. Check the Link box 
to link the object or leave the box unchecked to embed the object (so 
it’s independent of the original file). Or, to create a new ImpactPlus 
object, choose the Create New option. ImpactPlus opens with the 
Startup Wizard (or a blank scene window if the Wizard is turned off). 
When you’ve created the scene, choose Update from the File menu to 
insert the scene as an object (or update the image already there) 
without closing ImpactPlus. 

To edit an ImpactPlus object in any application, double-click the 
ImpactPlus OLE object within the application, or select the object and 
choose the application’s Edit Object command. In Serif PagePlus, 
either action will launch ImpactPlus, displaying the scene ready for 
editing.  

When you use OLE to create an ImpactPlus object in a client 
application such as Serif PagePlus or Microsoft Word, the object’s 
resolution—its quality when viewed or printed from the client 
application—depends on the ratio of its dimensions in ImpactPlus to 
its dimensions in the application. For example, suppose you have set 
the dimensions of an ImpactPlus object to 300x300 pixels using the 
Scene Setup dialog. If the object occupies a 2-inch (5cm) square on the 
client application’s page, its resolution will be 150 pixels to the inch 
(300 divided by 2). If you resize the object to a 1-inch square in the 
client application, its resolution will increase to 300 pixels to the inch. 
Conversely, if you incease the object’s size, its resolution will 
decrease. 

For additional details on using OLE, see the How To topic “Linking 
and embedding” in online help.

    


